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INTRODUCTION

Information about the structure
and content of this document can
be found here.




CRM - Important notice

Important notice
This manual will help you get started with the easyjob 6 rental software CRM module.

The development of the easyjob rental software as well as the documentation has been done
with great care. The individual program functions are constantly checked through our Quality
Assurance Process. However, errors can still occur.

Main Office
protonic software GmbH
Frankfurter Landstr. 52
63452 Hanau

Germany

http://www.protonic-software.com

Support
You can find more information about the support options on-line at http://www.protonic-
software.com/en/easyjob/corporate/support/.

In addition, there is a support forum where you can exchange information with other users. The
support forum can be found at http://forum.protonic-software.com

Training
We offer customized training programs for the following extensive topics.

To learn more, please visit our website at
http://www.protonic-software.com/en/service/training/ and our sales office at

sales@protonic-software.com.

About this manual

The individual functions are described using screenshots of easyjob license 6. Depending on
your easyjob license, the forms you have in your environment may differ from the screenshots
shown in the manual.


http://www.protonic-software.com/en/home/overview/
http://www.protonic-software.com/en/easyjob/corporate/support/
http://www.protonic-software.com/en/easyjob/corporate/support/
http://forum.protonic-software.com/
http://www.protonic-software.com/en/service/training/
mailto:sales@protonic-software.com

CRM - How to use this manual

How to use this manual
This document uses the following standards

Functions that require a license
Individual program functions are made available in your easyjob environment based on your
license. This may concern individual program functions or entire modules.

Functions that are only available in individual modules are marked with minimum-edition
symbols =, m, B or ><. Some functions are limited in easyjob S. There is no indication of
this. You can find the limitations in the version comparison matrix on our website.

Functions that are only available by subscription are marked with the symbol \..

For example:
i The function is only available in easyjob L
and easyjob XL
B\ The function is only available in easyjob L

and XL with a current subscription.

easyjob-specific terms
In order to make a description better understood, in some cases easyjob-specific terms are
highlighted with a color.

For example: with the Project and Job groups, you also have the possibility to select a
Template.

Work steps, buttons, actions and menu paths
Individual work steps, actions, menu paths or clicks are separated from each other or initiated
by the symbol ">

Buttons, menus, tabs, etc. used in context are highlighted in color.
Example 1: Check the box in the Activating the List Editor field.
Example 2: easyjob Menu o View > Monthly Overview
Example 3: @ Help

Example 4: p Ok

Reference to other chapters
References to other chapters and sections are underlined and displayed in orange.

Example: See section ¥ Important information.



CRM - How to use this manual

Important information
Important information is highlighted in orange and presented with a light bulb.

Example:

Special keys

Special keys are represented with the following symbols:

+ A

+ H

Phrasing

Windows key
Tabulator key

Arrow keys

Return key

Context Menu key

Escape key

Function key 1

Control key. Keep the control key pressed down and press the A button.
Alt key. Keep the Alt key pressed down and also press the H button

Delete key

In this manual and in the easyjob examples, terms such as employee, assistant, technician or
carpenter are used both for men and for women.



CRM - Additional documentation

Screenshot explanations
The screenshots will be explained using numbers ¥ ** & and arrows ** marked.

Screenshot highlights will be marked with orange frames.

Invoices B
From 15/01/2117 . Tupe am | Company | Standard ~
Tao Status <Al e
Keypword 1197|  Reminder Status -
Custamer All | Site
Mumber  Name Invoice Date  Total Totalincl Tax- Mamel Status Paid  Tems of Payment Open A
13-0006  Big Show 27/04/2015  £36,00000 £36,000.00 Big Events Inc. Open []  BigPraject Pagment Plan £36,000.00
13-0008  Downtown At Exhibition 27/04/2M5  £16,65000 £17.833 50 Open [] BigFroject Fagment Flan £17.833.50
12-0007  Big Opening Shopping Mall b 14/04/2016 £7.150.00 £7.865.00 Open [ BigProject Payment Plan £7.865.00
12-0004  Bia Opening Shopping Mall 2 1470472016 £7.150.00 £7.865.00 Open [ Big Project Pagment Plan £7.865.00
12-0006  Big Opening Shopping Mall 1a - 14/04/206 £7.160.00 £7.858.00 Open [] BigFroject Fagment Flan £7.858.00
12-0002  Big Opening Shopping Mall e 14/04/20M6 £6,300.00 £7.043.00 Open [  Remit within 30 days £7.043.00
12-0001  Repair 23/03/2016 £1.160.10 £1.170.21 Open [0 Pre-paid by credit card €1.170.21
02-0001  Sample Project 261172012 £4532.00 £432.00 Max Sample Customer  Exported [ Femi within 30 days £452.00
10-0001 21/04/2015 £1.00 £1.00 Open [ BigProject Payment Plan €1.00
13-0009 27/04/2M8 £0.00 £0.00 Open [ Big Praject Payment Plan £0.00
13-0007 CATS Revue 27/04/2015 £0.00 €0.00 Open []  BigProject Pagment Plan £0.00
130005 Big Show 27/04/2015 £0.00 £0.00 Open []  EigProject Payment Plan €0.00| v
| Totals Duantity 17 Total €82.053.10  Totalincl. Tax £86,199.71
Print Add Close

Additional documentation

In order to make it easier to become acquainted with and consult the easyjob documentation,
we have divided it into multiple sections.

You can find an overview of all documentation on the following website.

http://www.protonic-software.com/en/service/downloads/


http://www.protonic-software.com/en/service/downloads/

CRM

The easyjob Customer Relationship
Management CRM helps you
optimally manage and document
your customer relationships.




CRM

The easyjob CRM (Customer Relationship Management CRM) module helps you optimize your
communication with customers, partners and suppliers. You can directly address your
customers with activities, campaigns and marketing lists. With the CRM Dashboard, you can
provide your Sales Team with a wide range of information and data in order to recognize sales
potential and improve customer loyalty.

11



CRM - Installation and activation

Installation and activation

Go to the easyjob program settings to activate the easyjob CRM module: A separate

installation is not required.

Activating the CRM module:

1. easyjob Menu o Tools o Settings

2. P> Programm Modules tab
3. Select CRM

© options

Active Program Modules
Invsicing
Purchase Order

General

Program Modules

Integration Workshop
Ssles
Projects
P Ree
Jobs Planning Resources
[] ltem Packa
Bill of tems ol
Price Lists
ttem Days Used curve
e Py e
Groups price caleulation
Dlecanb Partial delivery
Imvaicing Sales tems
Ownership Management
\workshoy
o i rentalmarket. biz
Purchase Order Freelancer

Mabile Devices
GQuick Transfer
e Outside Broadeast Units

rentalmarket biz

e

CRM

Controlling Center

Driver Cards

Manufacturing

Quality Assurance
Advanced Test Process
On-site Test Documentation
Time Card Analyzis
Viebdpp

\nieb shop

Mulli currency

Base Currencies
Languages

Business Travel Planner
Room planning

Stock Location Management

\orkflow Engine

Cancel

4. P Ok

easyjob must be restarted to activate the settings.

12




CRM - Configuration and settings

Configuration and settings

User settings
There are various rights available for the CRM module in the User Rights Manager.

Assigning the user rights for CRM:

1. easyjob Menu o> Tools o Manage Users

[ Select a User

o Edit

[ Access Rights tab

[ General

Assign the desired rights (e.g. view confidential activities or agreements, etc.)

£, User Settings - O 'Y

o gk~ wN

User AccessRights  SecurityRoles Rights Result Reminders CRM Reports Statistics
Right Global

=l CRM
Master Data

A

View Campaign

Edit Campaign

View Activities

Edit Activities

Wiew Activities of other Users
Edit Activities of other Users
CRM Dashboard

View confidential Activities
Delete Activity

Change foreign Owner

View Agreement

Edit Agreement

00 JREERREEREE

v

swe |[_ ok || camcel |

Creator: sys admin (01.09.2017 13:21) Last Edited: Brad Casagni Brighton (07.05.2018 12:56) @
7. P Save
8. P Ok

13

© protonic software GmbH



CRM - Configuration and settings

User email addresses

In the user settings, you can define a specific email address as well as the user-related SMTP
access data for each user. All outgoing emails will be sent within the context of the user. If
emails should be sent with a global email context, keep the email address open.

User AccessRights SecurityRoles Rights Result Reminders CRM  Reports  Statistics

E-Mail Settings
E-Mail Address CRM@protonic-software .com
s e

Password

Soe oo

£, User Settings - O 'Y

Creator: sys admin (01.09.2017 13:21) Last Edited: Brad Casagni Brighton (07.05.2018 12:58) (1)

Setting up the e-mail address for a user:

1. easyjob Menu o Tools p» Manage Users
I Select a user P Edit

I CRM tab

Enter the e-mail settings

o> Save
I Ok

ok wN

SMTP email settings

easyjob sends all email messages directly via SMTP. No additional email program is necessary.
Simply configure your email parameters in the easyjob program settings.

Defining the email settings:

1. easyjob Menu o Tools > Settings

rentalmarket biz | E-Mail Settings
Use default settings

Controling Center | TP Server
il Port 25 Timeoutls 120
Sender E-Mail
Vieb shop Sender Neme  easyiob

Mbile Scanner User
Passwiord
wiebApp

Secure password authentication (SPA)

Quality Assurance | Test

Template

2. P> CRM tab
3. Enter the corresponding data under email settings
4. Use Test to test the account settings.
5 POk
© options - 'Y
Workshop General
Create Print Activity
Purchase Qrder Create email Activity with Outlock

Template Type

CRM

Time Recording

Edit

Delete

Cancel

easyjob must be restarted to activate the settings.

14




CRM - Configuration and settings

Email activities using Outlook

You can use the CRM email toolbar to create various email activities directly via Outlook. When
creating a new email, you can assign Addresses " * and Processes & (see also F Activities in
the reference type) from easyjob on the easyjob tab ¥ . The selected email address and the
name of the workshop activity are automatically entered in the Recipient 5 and Subject line
%.

HS O = 18-0008 I TC Show - Message (HTML) = O

oK -
File Message Insert Options Format Text Review j PDF-XChange @ Tell me what you want to do...

D /| Create Activity
X Event !QOOE ITC o

Productions~  Show
CRM -~

1=
{ & P

Send
Subject 8-0008 ITC Show

O, 18-0008 [TC Show Project Proposal2.pdf

Attached
et L& 0rks

Dear Sanne,

Thank you for your Email. Please find attached our proposal.‘

The emails are automatically assigned to the activities of the respective Processes ./, if Create
Activity & is activated.

& Contact - O 'Y

MainData Ad: d Activites C. icati Blocking | ndk CRM

All Activities for an Cortact are displayed here

stan [ & 82018 ~| End[FA 77152018 +| Manager [ || Brad Cassgni Brghton [ Include Groups

Kepword | | 21 oy rurring activities

Start End Tepe MName Pricrity  Direction  kManager Finalized Fegarding A

BA5/2018 BAB/2018 0y 18-0008 I TC Show Nommal  Outgoing  Brad Casagni Brighton B Project: 18-0008 ITC Show

5/29/2018 5/29/28 B Customner question about proposal Mormal  Incoming  Brad Casagni Brighton O Project: 17-0021 Project Future

B/23/2018 5/23/2018 [ Check if event wn fine Mormal  Outgoing  Brad Casagni Brighton O Project: 17-0013 Summer Revival Festival

< >
Add Edt || Delste

Attachments —

List  Preview

Name Description  Mame
I —
18-0008 ITC Show Project Proposal2 18-0008 ITC Shaw Project Proposalz.pdf

< >
Scan execute

Save aK Cancel

Creator Last Edited: Brad Casagni Brighton (5/8/2018 10:44 AM) @D

When you receive an email, you can create a new Activity  from it directly.

H + s R Transuniverse Main - Message (HTML)
File Message [Tl POF-XChange Q' Tell mewhat you want to do..
1Y ’_‘\}\

£l [a 1

&0

Creste Op T

Activity add

CRM -~

15



CRM - Configuration and settings

Setting up the CRM email tool:

1. easyjob Menu o Tools o Settings

2. P CRMtab

3. Check the box Create email Activity with Outlook
4,

I Ok

@ options = O %

PurchaseOrder | General
[] Create Print Activity
rentalmarketbz | [ [ Create email Activity with Outlock |

Controling Center | E-Mail Settings
Use default settings

B SMTP Server
st Port 25| Timeows | 120
Sender E-Mail
Mobile Seanner Sender Name easyiob
webfpp User
Password
SRR Siinre i e boaton [SER)
Manufacturing Test
Templote

CRM

Template Type

-

Add Edit Delete

-

easyjob must be restarted to activate the settings.

Templates

With the help of templates, you can initialize Document and Email activities. First create a Word
document, assign a name to it, enter the desired content and then save it. You can use DOC or
D files for the document type. Email templates are saved in HTM format (TXT format for
Outlook).

© Options B - X
Imégicing General
[[] Create Print Activity
Workshop [ Create email Activity with Outlock

PurchaseOrder | E-Mail Settings
Use default settings

rentalmarketbz | g7 Server
Contraling Center Port 25 Timeout's 120
Sender E-Mail
R Sender Name easyiob
\nieb shop e
Password
ke conner Secure password authentication (SPA)
\lebipp Test
Templat
Quality Assurance ||
Template Type
Earlybirdrate tet TEXT
cRM SommerSpecial_withVariables.docx DOC
SpringSpecial_withVariables htm HTM
WinterSpecial_withVariables docx DOC
b
Add Edit Delete
-
=

1. easyjob Menu o Tools o Settings
I CRM tab

o2 Add

[ Select the template

I Ok

a bk~ wnN

easyjob must be restarted to activate the settings.

16



CRM - Configuration and settings

Variables

In CRM, there are many variables that you can integrated into your templates for documents
and emails. When performing the activity, the variables used will be replaced with the
respective data that was created in the activity (e.g. name, address). The selection of the
variables " * can be found in Design mode ¥ of the activity email " *. With Preview & you
can check your entries. You can copy the created content to a Word document and manage the
layout as you prefer. If your want to prepare an email template, we recommend after creating

the Source text 5 to save it in HTM or TXT format.

O

Done

Canfidential [

3 Activity = O
General | Aftachments
Type [E-Mai | 1000003.00 Edit | | Del
Name [Spring-Special | | XY Event Productions
Date 07052018 ~ -MDS Time 101 Sample Drive
A 75313 Dales
Manager & || Brad Casagni Brighton v f_T)

o ‘2| Phone 123-456-7892
Ernity Nomal ¥ Mobile Phone 01234 88883
S Outgoing B Company Phone  123-555-0000
Duwaon | 0| @

Reminder

Regarding | A [ Z][X

Text

oo @iy He@ q
Arial QWF* B I U === EEA- [E® Vbl

season.

Find an oveniew of possible combinations in the enclosee flyer.
‘We're looking forward to welcome you again!

Best regards,

{Activity Manager Name}

{Activity.Manager.Address.Company}

{Activity. Address.Contact.Salutation} {Activity. Address.Contact.First Name} {Activity Address.Contact.Last Mame},

Spring is coming! It's time for our Spring Specials! With our Early Bird Rate you can save attractive conditions for this

Send Save oK

Creator: Brad Casagni Brighton (07.05.2018 14:11) Last Edited: Brad Casagni Brighton (07.05.2018 14:15)

Cancel

Creating a template with Variables for documents/emails

1. easyjob Menu > CRM o> Activities
2 Add

> Email type

2 Ok

[ Variables

Select the desired Variables

Variables x

o oA w N

Variable A
Aetiving Address. Firsth ame

ActivipAddress. Middle_Name

Activity Address Name

ActivitpAddress. Barcode

Activiy.Address. S alutation

ActivigAddress. Street

Activitp.bddress.Zip_Code

ActivigAddress. City

Activitp.bddress.Phane

ActivigAddress. CompanyPhone
Activity.bddress.MobilePhone v
< >

Ok Cancel

7. POk
8. Manage the content as you prefer

17




CRM - Activities

Activities

Activities document all types of correspondence inside and outside your company. When
creating an Activity ¥, select the type. (e.g. task, phone or appointment). More information
can be found in the Activity Type section. You can enter a wide range of details for every
activity and filter them as required (see F Activity overview) or analyze them using the easyjob
Business Information Center.

8 Activity - o X
General Attachments
O \ @oovcz0 at | [ Da
Name [Complaint Invoive Missing kems | & || XY Event Productions ~
Date 07.052018 |[13:03 | Time 101 Sample Drive
3 A | 75215 Dales
Manager £. || Brad Casagni Brighton v ‘:)
: /| Phone: 123-555-0000
Priority Nomal >~ Mobile Phone 01234 88889
¥ v
Direction e ) Company Phone  123-555-0000
busion [ 10 @
Reminder  [1[07.05.2018 1 Tm-Q
Done O
Confidential [ Q@Q
Regarding  [17-0013.01 Summer Revival Festival [ X
Text
A - )
Arial <o - Bz U H2=E=H EE A~ @ Template
Client complains about invoice. Details explained. Now accepted. A
Save OK Cancel
Creator: Last Edited:

Enter the Name " *, Date and Time &, the Manager who created and documented the process
S (this can be changed if you want to assign the Activity to a colleague, see also  CRM
Owner. You can also assign activities to a User Group, assign the Priority % (high - normal -
low), the Direction & (incoming - outgoing), the Duration ./, a Reminder  (date - time),
mark the activity as Done ), as Confidential ¥ (see also F User settings), select a process
regarding this activity § , add a text & and attachments A . You can create RTF Templates for
Activities. More info can be found in easyjob 6 manual.

The process to which the activity refers is called the Reference Type. This means, for example,
an Address, a Project, a Rental Job, an Invoice, a Purchase Order, a Sales Job, an Item or a
Workshop Activity. You can use the magnifying glass & to open the Reference Type selection,
and at the end you can select the related process, edit existing ones f or delete them . By
selecting the Reference Type, (e.g. invoice) and the related Process (e.g. project name)
Activities are automatically assigned to the selected invoice.

4 Invoice ABC Product Lounge Part 2 (17-0024) [ )
Main Datz Address
Invoice Number | 17-002¢ [ ] selustion Dear i or Madam v
Date Name 1 XY Event Productions
TexType Local Dals v Name 2
Reminder Status v Strest 101 Sample Drive
Manager £, || sys admin v Zip Code, Gity [75213___|[Dalas
Pipress e 000 Fr [ Psid Country Urited States <

Invoice tems  Advanced  RTF Fields FPayment Receipts | Act ancial data  Blocking Indicator  Workflow

) ni Brghton [ include Groups
| 1 Oy running Activiies
Start End Type Address Contact Name Pricrity Direction Manager Finalized Finslized by
07052018 07052018 )  Events Schweiz AG Change Invoice Address  Normal Dutgoing  Brad Casagni Brighton Brad Casagni Brighton
I
Add Edit Delete
Print Finalize oK
Creator: sys admin (25.08.2017 14:04) Last Edited: Brad Casagni Brighton (09.04.2018 11:56) |®

18
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CRM - Activities

Creating activities
The process for creating activities is identical in all areas.

Creating activities, e.g. in a project:

1. easyjob Menu o Projects g Edit Project
Select a project

2 Ok
[ Activities tab
o Add

Create Activity x
Type [7] O Task
51 O Document
SommerSpecial_withVariables.docx
£ O E-Mail
SpringSpecial_withVariables htm
O Fax
B @ Phone
7] O Appaintment
[ O Advertising Media
& O Note

a s~ ownN

Cance
6. Select the type of activity

7. POk

8. Enter all the information about the activity

B Activity - O 'S

General | Aftachments

Type [Phone | 1000003.00 Edit | | Del
Name ‘Customer question about propasal | = || XY Event Productions ~
® | Kordes Sanne
Date 07052018 +|[14:30 | Time 101 Sample Drive
- A | 75215 Dales
Manager & || Brad Casagni Brighton v “D
= | Phone 0123 8888-21
Ernity Nomal L Mobile Phone 01234 82889
S
S ncoring B Company Phane  123-555-0000

Durstion ]
Reminder O 19:30 | Time
)

Done
Canfidential [

Regarding | 17-0021 Project Future I alEs

Text

9 - @Gy

Adial Juw q ey S=EEE EE A @ Template

1. Customer wants confirmation that all projectors are not older than 3 years. ~
2. All other competitors includes cabling (VGA, RGEHV). Customer asked for doublecheck (discount).

Save oK Cancel
Creator: Last Edited

9. p Ok

Creating activities from the easyjob Menu:

1. easyjob Menu > CRM o> Activities
2. P Add

You can add additional documents to an activity. Select the Document tab and click Add. More
information can be found in the easyjob 6 user manual in the Document Management chapter.

19



CRM - Activities

Activity Type
You can create different types of activities, such as Task, Document, E-mail, Fax, Phone,
Appointment, Advertising Media, Note or Event.

Create Activity x

Type [7] @ Task
[F] © Document

SommerSpecial_withVariables.docx

£ O E-Mail

& OFax

B O Phone

(O Appaintment

() O Advertising Media
K] Olote

Carel

Task
By using the task Activity Type, you can create ¥, edit and track as many tasks required for
yourself or others. You can freely define the Task type * " in the Master Data.

7] Activity - O 'Y

General | Aftachments

Type [Task | 1001013.00 Edit | [ Del | []
TookType Ut V‘e ® | Prosound ~
" | Silva Johnson
Name [Welcome CEQ | Pakerst. 50
New York
Start 07052018~ |[10:00 | Time End[07052018 +][1030 | Time 3
Phone 123456789
Maniager £, || Brad Casagri Brighton - Mobile Phone 123456789
. Company Phone 123456789 v
Pricrity Nomal -
Direction Qutgoing ~
Duson | 0| @
Reminder 1938 | Time
Done
Regarding ‘ | Q|2 X
Text
AL -
Arial {10 - B ru SHEHEE EE A E Template
7
v
Save oK Cancel
Creator: Last Edited:

Adding the task type in the Master Data:

1. easyjob Menu o> Master Data g Task Type
2. P Add

3. Enter a Name

4

I Ok

0 Teskypes =]

Name

Check budget limit
Check location

Check power supply
Create Gobo
Inspection

5 p Ok

Quick Task

You can create a task type activity even faster using the key combination CTRL +T. Regardless
of where you are in easyjob, this combination opens a new activity and you can assign a task to
yourself or others.
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Document
With the document activity, you can select Word documents that you previously created as a
template and edited as required.

Create Activity x
Type [7] O Task
QD (®) Document
[SommerSpecial_wihVarables.docx &

{2 (O|SommerSpecial withVaniables docx
WirterSpecial_withVarizbles docx

O Fax

B O Phone

O Appointment

() O Advertising Media
& O Note

Carel

The templates can contain Variables, which are populated with various details from the activity
(salutation, first and last name from the Address) when the document is opened. See also ¥
Templates and F Variables.

[ Activity - o X
General | Attachments

Type [Document (SommerSpecial_withVariables) | 1001025.00 Edit| [Del | []

ame [Snap the chance! | S\:Zsﬁ;v;zm AG ~
Date Time Tavbensiass 12

lanager £ || Brad Casagni Brighton D

o Company Phone  00412290980000
Priority Nomal v Fax: 0041229098002
Direction Outgoing v &
Duration E D

Reminder  [][07.052018 ][19:42 | Time

Done QD

Regarding ‘ ‘ Q|2 X

Text

9 B

Arial o B ru EEEE EE A @ Tempot

~
v
Qpen documente Save OK Cancel
Creator: Last Edited:

The name of the selected document ¥ is displayed in brackets. In this Word example,
Variables are set for the fields Name **, Manager & and Address $5. After pressing Save %
and Open document &, the created document is opened.

= 5 Sy C Sut. 1978 5 5 Sy C Sut. 1978
{Activity.Address.Company) oEvean Schweiz AG
{Actwvity Address Contact FirstName} {Actiity Address Name} Dieter Nussbaum
{Activity. Address.Street) Taubenstrasse 12
{Activty.Address ZipCode} {Activity. Address.City) 1240 Genf
{Activity. Manager Address City}, 11th May 2018 Brighton, 11th May 2018
{Activity.Name} QSnap the chance!
{Activity Address. Contact Salutation} {Activity Address Contact FirstName} Dear Dieter Nussbaum,
{Activity Address. Contact LastName},

Christmas is coming! We have already presents for you!
Christmas is coming! We have already presents for you! b

Save aftractive conditions for you today!

i iti fi h " o 3 P - @

Save attractive conditions for you today! Find an overview of possible product combinations in our enclosed fiyer.
Find an overview of possible product combinations in our enclosed fiyer . ;

We are looking forward to welcome you as our customer again
We are looking forward to welcome you as our customer again

Kind regards,

o @rad Casagni
astNar

Kind regards,
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You can now print out the document and continue using it. After the document is opened &,
the activity is automatically set to Done ./ and the created document is saved in the activity
under Attachments .

[ Activity - O 'Y
General | Attachments
Type |Document (WirterSpecial_wihVariables) 1001025.00
Name Snap the chance! 0 Evertts Schweiz AG 5
Diter I
Date 15:08 | Time Taubenstras:
1240 Genf
Manager 1! Brad Casagni Brighton
= 00
i Company Phone DO
Friority Nomal e D04
v
Direction Qutgoing
Duration )
Cerinde 055 | Time
7
Regarding | [ X
Text
-
v
Open document Ok & Hew Save oK Cancel
Creator: Last Edited:

Create a new activity with Ok & New ). All entries are kept and you can create the same
document for another customer by changing the address .

If you want to create and print out this document for many customers, we recommend creating
this activity in a campaign. In order to print all documents together, you can select them in your
easyjob global directory after starting the activity and print them out together.

Printing documents created in a campaign together:

1.) Open the global directory ¥

2.) Enter the name of the created document as search text " "
3.) Highlight all documents to be printed &
4)

[ Print

I 1 Group by~ [ ttem check boxes 5 =
[Ti14dd cotumns - [ File name extensions -

Sort oo Hide selected Options
by~ fiSize all columns to fit | [] Hidden items s <t

Current view Show/hide

Type Size

ecial_withVariables

21PM Open
21PM e
018 1:21 PM New

Print
EHl Scan with Windows Defender.
12 Share

PDF-XChange Editor
ombine in PDF-XChange Editor

Give > |
Sendto b
easyjobbensR7 =
Eception Log oy
Intel
e Creste shorteut
Perflogs 8% SommerSpecial_withVariables Delete
Rename
Properti
shal v >
17items 10 items selected 314 KB =
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E-mail

With the E-mail activity, you can create, manage and document all processes that are handled
via e-mail. An e-mail activity can be marked as Confidential ¥ and viewed only with a
separate user right. More information can be found in User settings.

() Activity - O 'Y

General = Attachments

Type [E-Mai | 1000003.00 Edit | | Del
Name [Spring-Special | ® | XY Event Productions ~
Date 07052018 ~ -MDB Time 101 Sample Drive
- A 75313 Dales

Manager & || Brad Casagni Brighton ~ O

o ‘2| Phone 123-456-7892
Ernity Nomal ¥ [ Mobile Phone 01234 88889

v

. s B Company Phone  123-555-0000
Duwaon | 0| @
Reminder O 1908 | Time
Done O
Confidential
Regarding | o]
Text

9t B XA Q
Arial -lipt - B I U SEEE EEA- @S Verable

{Activity.Address.Contact.Salutation} {Activity. Address_Contact.First Name} {Activity Address.Contact.Last Name}, )
Thank you very much for yout inquiry. We hope everything meet your expectations |

Best regards,

{Activity.Manager.Name}

{Activity.Manager Address.Company}

Q= 5 | o

Creator: Brad Casagni Brighton (07.05.2018 14:11) Last Edited: Brad Casagni Brighton (07.05.2018 14:15)

You can create templates with Variables * " in the same way as for documents. More
information can be found in Templates and Variables. Some settings are required before an e-
mail can be sent. See also F SMTP email settings or F Email activities using Outlook.

Fax
With the Fax activity, you can document incoming and outgoing faxes.

Il Activity - O 'Y

General  Attachments

Type [Fax | 1000002.00 Edit | | Del
Name |Proposal Stage | SIS A
e atric atel
Date 07052018 (1512 | Time 3 Bing Bing Tral
12345 Miami
Manager .|| Brad Casagni Brighton ~ &
s Phone 1234567891
Frinity Sl = Mobile Phone 0177 12345
v
L s 5 Company Phone  123-555-0000
Dusin | 0@
Reminder [ 2018 | Time
Dane =]
Regarding | | o R
Text
9 @G
Arial o - B I U SEEE EEA-EF Templae
Dear Sir or Madam, ~

find attached the proposal as discussed.
Don't hesitate to contact us for further assistance!
Best regards,

L4
5‘. 'i C S 1978

Save oK Cancel

Creator: Last Edited:
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Phone

Here you can document all activities that are handled on the phone and, if necessary, mark
them as Confidential ¥ .

B Activity - O 'Y
General  Attachments
Type [Phone 1001017.00 sl
Name Question f damage could be repaired - Audio Visual Service s
Tom Easy
Date 052018 15:23 | Time
] Dallas
Manager | & || Brad Casagni Brighton 3
L ~ Phone
Priority Normal Company Phare
v
Direction Qutgoing Bt Wioosi
Duration
3 2023 | Time
Done
Confidentizl [ °
Regarding | 12-0002 Repair IEXZAlES|
Text
~
v
[okaNew |[ Sove oK Cancel
Creator: (07.05.2018 15:24) Last Edited: Brad Casagni Brighton (07.05.2018 15:25)

Appointment

Here you can create, document (e.g. attach the diary and the record as a document) and
manage appointments,

Activity - O X
General | Aftachments

Type [Appointment | 1001012.00 Edit | | Del

Name ‘Meeting with customer | - Prosound A

" | Silva Johnson

Start Time Emi Time Pﬁgﬁéiﬂ

St & || eed Casnop Biriey = = Phone 123456789

Priority Nomal ~ Mobile Phone 123456785

Bircstion = e = Company Phone 123456789 v
Duafion | 0|

Done O

Regarding | 17-0013.01 Summer Revival Festival IESPAIES

Text

9™ @B g

Arial Jiwo s ru gEE=E A - @ Template

- Please bring last summer event presentation with you. ~

v
Save | oKk || Cancel
Creator Last Edited:
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Advertising Media

The Advertising Media type of activity supports the distribution of Advertising Media. You can
create the Advertising Media in the item master data as Expendable Items. Select the Quantity

¥ and the Advertising Media " * in the activity. By checking the Sent & box, an Inventory De-
letion is created.

(1 Activity = O x
General | Attachments
Type | Advertising Media | ADDORK .00 Edit | | Del
Name ‘New customers action | = | XX Event Productions -
Date 07052018 ~ -1531 Time i 101 Sample Drive
- A 75213 Doles
Manager £ || Brad Casagni Brighton ~ ®
; L/ Phone 123-555-0000
Quantity (5 % i Mobile Phone 01234 88889
- . w
- [1007781.00 USB fiash cnve 48 wih branding ralE Gy thine. 15 550000
Sent
Regarding | | [ X
Text
oo @By ¥
Al Juo B ru HEEE EE A E Tl
~
v
Save oK Cancel
Creator; Last Edited:

For a simple note, you can create an activity and mark it as confidential, if necessary.

] Activity - O 'Y

General | Aftachments

Type [Note | AT Edit | | Del
Name | General | ® | AV Rental Depot A
% | Paul Dancer
Manager . || Brad Casagni Brighton ~
Confidential [ Eelas
N
- Ph 4434700
Regarding | 100778100 USE flash drive 4GB with branding IEN A ES Cu;"‘fmphm S0
Home Phone 4434700 v
Text
90 B
Arial o - B I U SEHEE EEA-E Template
Order more capacity. ~

Save oK Cancel

Event

You can create an Event activity in campaigns. You can document the status ¥ of the event
attendance via a selection menu * * which provides you with an overview in the campaign of
the status of the individual participants. See also F Event attendance.

Y Activity = o X
General ' Attachments
Type [Event attendance | 1000001.00 Edit | [ Del | [ ..
Name [10 years anniversary event | @, [ ACME Pro Inc ~
" | Jim Johnson
Date 05052018 v |[__ | Time 60000 Cash Court
98101 Seattle
Manager £ || Brad Casagni Brighton v
Phone: 1234567890
[4 Use CRM owner from Address Mobile Phone 1225851111
e Company Phone 123-555-0000 v
Done
Regarding 7 X
Text
9 o
Arial o /B sU A~ @ Template
A
v
Save OK Cancel
Creator: Last Edited:

25



CRM - Activities

Activity in the print dialog

After you have created a Proposal, for example, you can create an activity (e.g. a phone call to
discuss the Proposal, or a task for expired Proposal deadline).

Creating an activity from a print dialog:

1. Click the Print Icon on the toolbar

2. Select the report for a Job Proposal
3. Select the desired Job
4

2 Ok

= Print X

Printer First Page
<Standard> vk

Printer Following Pages
<Standard> v

Options
Copies E
Output
@ Printer O Preview O File

[

Format

reate %]

lame [Summef Revival Festival

ate 20052018 |
s
Phone
|00 Quick Design Edit Cancel

5. Under Activity, check the Create ¥ box
6. Enter aName "", a Date & and set the Activity Type
7. POk
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Activity overview
You can display activities in the overview according to various filter criteria. In addition to the
Period ¥, you can limit the selection via the Manager * *, Include Groups & in which the

selected manager is a member, the CRM Owner 95, Type %o, Direction &, Priority /,

selection of Only running Activities ¢, Address Y, Reference Type ¥, the Process it concerns
i and using a search text <.

O+ Activities e Q oo =
07052018 | To[4114.052018 | "Manager [] |® [ Include Groups™Owner [] | ®
fype [ Appointment irection [] |Incoming °Pr«onty [ [Hish ] Only running Activities
ress 4| Regarding |<Al> Q 21X
rch text |

Stert End Type Name Priority Direction Manager Finalized Finalized by Regarding Level ~
07.052018 1509 07.05.2018 15:09 Snap the chance! Normal Outgoing Brad Casagni Brighton Brad Casagni Brighton Address
070520131509 070520181509 [ Snapthe chance! Normal Outgoing Brad Casagni Brighton Brad Casagni Brighton Address
07.05201815:09  07.05.2018 15:09 Snap the chance! Normal Outgoing Brad Casagni Brighton [ Brad Casagni Brighton

07.052018 14:49  07.05.2018 14:49 Snap the chance! Normal Outgoing Brad Casagni Brighton B4 Brad Casagni Brighton Address
07.05201814:42 07.05201814:42 [  Snapthe chance! Normal Outgoing Brad Casagni Brighton Brad Casagni Brighton Address
07.05201814:30 07.0520181430 §  Customer question aboutproposal  Normal Incoming Brad Casagni Brighton O Project: 17-0021 Project Future Kordes Sanne
07.052018 1408 070520181408 &  Spring-Special Normal Outgoing Brad Casagni Brighton ] Address
070520181314 070520181314 &  Change Invoice Address Normal Outgoing Brad Casagni Brighton Brad Casagni Brighton  Invoice: 17-0024 ABC Product Lounge Part2  Address
070520181303 070520181303 ®  Complaint Invoive Missing ltems Normal Incoming  Brad Casagni Brighton O Job: 17-0013.01 Summer Revival Festival

070520181000 070520181030 []  Welcome CEQ Normal  Outgoing  Brad Casagni Brighton o Address
061020171521 061020171521 []  Check budget Normal Outgoing Brad Casagni Brighton ] Project: 17-0117 Opening Central Station Prag  Address
061020171422 061020171422 &  Problem Invoice Normal Incoming  Brad Casagni Brighton O Invaice: 17-0020 Bon Jovi Tour 2017 Address
061020171421 061020171421 &  Newclientbla Normal Outgoing Brad Casagni Brighton Brad Casagni Brighton  Project: 17-0037 Marathon Festival Address v
< >

List | Calendar Add Edit Delete

Q Close

A graphical overview is provided on the Calendar f tab. The Selection T field shows the
currently selected Day 3. You can carry out further actions - depending on the reference type -
using the right mouse key context menu %o.

L Activities

[E=RE=R o)

ress ][5 Regarding [<tt> <
Seorchtent | Qs,.mn [sas <

__[30.Ar 1. Mai 2 3 4 5 5

Q

3 67

=

2

i 10 B 0 i 12 13
10:00 ] Vielcome CEQ 10:00 [7] Mesting with custormer 1502 [7] Testnew soundsystem

E| 13038 C

&) 1518 ksl Proposal Stage Add ity

2| 1531 ©) New customers action Edit Activity

2

% EditJob
i 15 6 7 i 19 20

2

3 i
=
e 2 3] 2 % % z

14:08 (£ Spring-Special 16:00 ] Site inspection

=

E
= 2 30 3 1 Jun 2 3

14:30 | Customer question about
=
List | Calendar dd Edt Dele
Clos

Selecting activities from the overview:

3. easyjob Menu o CRM o Activities

4.
5.
6

Set the filters as required
Select an activity

o Edit
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Activities in the Address Book

You can use the Address Book to create an overview of the activities related to the selected
Address or the selected Contact and edit them if necessary. Use the up/down arrow key to
select the Contact or the Address ¥ . The related Activities * * will be displayed in the
information window. Also a timeline is available. See also ¥ Timeline in the Address Book.

by ] <> | <Al Continents> | A addresses [ Contacts [JLead |V
Type Number  Company Main Contact_Contact Selutation _ Contact First Name _ Contact Last Name _ Contact Phone _ Contact Phone Mobile _Contact E-Mail Seet
® Address  1000003.00 XY Event Productions 101 Sample Drive
& Contact 1000003.00 XY Event Productions Dear Sir or Madam 123-555-0000 01234 88889 info@xyevents.com 101 Sample Drive
Contact  1000003.00 XY Event Productions DearMadam  Kordes Sanne 0123888821 0123488889 skordes@xyevents.com 101 Sample Drive

@ Contact 1000003.00 XY Event Productions Hans Schmith 0123 8888-12

0177 888888 hschmith@xyevents.com 101 Sample Drive

<
Gmgd‘liﬁs CustomFields Invoices Total Sales Resources Jobs Rating Document Timeline Facebook

strt[J30042018 ] End[(£106.062018 v| Manager [ || [Biad CasagniBighion ' [] Include Groups

Keyword | | 1 Only running Activities

Start End Type Name Priority Direction Manager Finalized Finalizedby Regarding Level E-Mail
29052018 29052018 %  Customer question about proposal Normal Incoming Brad Casagni Brighton  [] Project: 17-0021 Project Future  Kordes Sanne
03042017 03042017 Y Invitation Normal Outgoing Clark Cafer Stockholm ] Kordes Sanne
30032017 30032017 Y Invitation Normal Outgoing Clark Cafer Stockholm (] Kordes Sanne
30032017 30032017 ¥ lnvitation by mail Normal Outgoing Clark Cafer Stockholm ] Kordes Sanne
26012017 26012017 ) Invitationtoeventtradeshow  Normal Outgoing Clark Cafer Stockholm [ Kordes Sanne

[ ps [[Es ][ ol |

oot (57 Comamimn ][] [t [ ] [

Activities in the reference type

The created activities are can also be found in the associated reference types (Addresses, etc.)
Available filter options include Period, Manager, Keyword search or Only running activities.
Activities can be added, edited or deleted.

Address

Main Data Contacs [ A 7 .' c Address Types  C i Invoicing Jobs SalesTrends Item Custom Fields DigiFlest
TimeCard Ti Ratings: biz Qualifications BlockingIndicaior Purchase lvoices CRM CRMAds ionships  Web
 All Activities for an Address are displayed here.
Seart[130042016 | End[106062018 | Monager [ |®||Biod Casagni Bughton | [ Incluce Groups
Keyword | | = Only running Activities
Start End Type Name Fricrity Direction Manager Finalized Finalizedby Regarding Level ~
29052018 29052018 ®  Customer question about proposal  Normal Incoming  Brad Casagni Brighton [ Project: 17-0021 Project Future Kordes Sanne
22052018 22052018 Spring-Special Nermal Ouigoing Brad Casagni Brighton [ Address
07052018 07052018 1)  Mew customers action Mormal Outgoing Brad Casagni Brighton [ ]
07052018 07052018 ®  Complain Invoive Missing ltems  Normal Incoming Brad Casagni Brighton [ Job: 17-0013.01 Summer Revival Festival
03052012 03052018 Y Invitation Normal Outgoing Clark Cafer Stockhelm [ Hans Schmith
< >
[ aaa [ E@t || Dees |

Dete || swe |[ 0k || cancel |

Creator: Last Edited. Brad Casagni Brighton (06.10.2017 14.35) @

Project

MainDats Ovenview i [ Activibes | Planni JobCosts Ces Post Caleulalion Pay Fields ices Workflow Rating
c Rooms Report Parameter OBUs

Al Proge et it e eplvea e

|U Project I Summer Revival Festival [l Zumietung AV Rental Depot
Start[J30062018 ~ ] End[A06062018 ~| Manoger [] [®|[BradCasagniBaghten | [ Include Groups

Keyword | | [ Only running Activities [] Display all connected activities
Start End Type Address Contact Name Pricrity Direction Manager Finalized Finalized by
08052018 08052018 T XY g ing i Normal Outgeing Brad Cassgri Brichien [
[ s [ Em [ D |
| Tvel || subRental || Overview || ToOutlook || Resowces | hems || Close |
Creator: Clark Cafer Stockholm (16,02 2017 10:05) Last Edited: Clark Cafer Stockholm (16.02.2017 14:43) @
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Job

Data Overview i | Activiies [Planni Job Costs Cost Plamer Post Calculalion Fields P soes Worklow Rating
3 q Ac Rooms ReportParameter OBUs

R e A R
T e PR
Start|[J30.042018 | End[[06062018 ~| Manager D@ﬂmm [ Include Groups

Keyward [ |2 Oy running Actvites
St End Type Address Cortact Name Priorty Direction _Manager Finslized Finalized by
07052018 07052018 # XY Event Productions Complain Inveive Missing ltems  Normal  Incoming  Brad Casagni Brighton [
[ oo [ e [ ool |
Travel || SubRental || Overview || ToOutlook || Resowces || hems || Close |
Creator: Clark Cafer Stockhelm (16.02.2017 10:05) Last Edited: Clark Cafer Stockholm (16.02 2077 14:43) @
Invoice
Main Date Address B
Invoice Number  [T70024 [ ] Saluafion | Dear Sor Madam ]
Date Name 1 [X¥ Event Froductions |
TocType —— |
Reminder Stalus Street [107 Sampie Dive |
e N T |
PaymentReceipt | 0DOFr []Pad Colnky | United States v
Title [8C Product Lounge Part 2 | DebitorlD.  [1350000020 ] Tax ! [USA123456789xx |

Invoice ltems  Advanced RTF Fields Payment Receipts

inancialdata | Blocking Indicator  Workflow
Start[[130.042018 ~| End[[]06.062018 ~| Manager [ i

Brad Brighton [ Include Groups

Keyword | |7 Only running Activities
Start End Type Address Contact Name Priority Direction Manager Finalized Finalized by
07.052018 07.052018 & XY Event Productions Change Invoice address  Normal Ouigoing Brad Casagni Brighton  []  Brad Casaani Brighton
[ sa || st |[Coeke |
| Pt || Finslee || oKk |
Creator: sys admin (25.08.2017 14:04) Last Edited: Brad Casagni Brighton (07.05.2018 13:16) @

Purchase Order

MainData Lineltems Resources =] Attachments CostPlanner Purchase Invoi

* Al Actvites for the Purchase Order are displayed here.
Srt[[J30042018_+| Ena[06062018 v| Manoger [ |®|[Bred Casaom Brghion | [ Include Groups

Keyword | (A Gy runing Activities
Start End Type Address Contact Name Priority Direction Manager Finalized Finalized by
07.052018 07052018 §  Abdullsh Aaron Room reserved Nermal Oulgoing Brad Casagni Brighton L3
07052018 07052018 &  AlanAndersen Send list of members  Normal Outgoing Brad Casagni Brighton [
[#ed ][ E@t | Deee |
Print || Lnetems | Sawe |  OK || Cancel |
Creator: Clark Cafer Stockholm (17.02.2017 12:28) Last Edited: Brad Casagni Brighton (19.09.2017 12:35) [ AO)
e
MainData Prices Inveniory Site Devices Associaledliems Jobs Alternalives Usage Report o ields i Image
Al B Jim Webshop Scanner Quality. ring Conlrolles biz Blocking ind
Al Activities for an ltem are displayed here. :
Start[[130.042018 v| End[[A06.062018 | Manager [] : | [ Include Groups
Keyword | &1 Only running Activities [] Display 2l connected zctivities
Start End Type Address Contact Name Friority Direction  Manager Finalized Finalized by
07.052018 07.052018 [T  Abdullah Aaron Advance booking follow-upmodel  Normal Outgoing  Brad Casagni Brighton [
07052018 07052018 g AV Rental Depot Confirmation order Normal Outgoing Brad Casagni Brighton ~ []

pelee || coy [ g || swe [ Ok geneel |

Creator: sys admin (16.04.2015 12:01) Last Edited: Clark Cafer Stockholm (07.09.2017 13:40) )

29

© protonic software GmbH



CRM - Activities

Workshop activity

Msin Data  Advanced [Activities| R
All activities for the workshop activity are managed here

Spare parts  log Test Results Cost Planner

Stert[[ 130042013 +| En[F106062018 | Manager [ |®|[Bied Casagni Bighion | [ include Groups

Keyword |

| 4 Oy running Activities

Start End

Type Address

Contact Name

Priority Direction Manager

Finslized Finalized by

07.052018 07052018 @ ‘Audio Visual Service ‘Check if the damage could be repaired Normal Outgoing  Brad Casagni Brighton
=
S |[ b [ P ([ See Ok | Gl |
Creator: Clark Cafer Stockholm (22.02.2017 09:58) Last Edited: @

Activities in the Resource Plan

Activities, such as the manager's tasks or appointments, can be displayed in the Resource Plan.
To activate the display, select Activities ¥
" * displays the relative Details &.

in the filter under Work type. Clicking the Activity

Defoult Own Staff  Vehicles
[Montag . 7. Mai 2018 v|[ Motag .14 Ma 2018 || | (&[] [ [Stockholm, Prague, Brighton ] [<event> ~
| Curent View> | Own siaff Job
Work Type " Mo.07.052018 6 [7 [8 [9 [10]11[12]13[14T6[16[17 181920121122 23]D7, 08052018 [6 [7 819 [10[11 A | Number 17001301 e
2 Resource Assignments (Casagni, Brad Vlelcome CEO (Urgent) Custom Number
[ Resource Status Name Summer Revival Festival
Activities (Appointments/Tasks) Statis Confirmed
Aot St ‘Advance booking follow-up model (Appointment) : g;;;x:;zx
0 [ Preferred Service Full-Service
A Requested User Milan Stava Prag
[ &4 Confirmed George, Finn Training Uil P8
11 [ Canceled ity
Type Urgent
Freelancer Status Name Meeting Project
(4 Prefered SevaProg. Miln | MesingPioject Urgent) | Meetingwithcustomer (Appointmentp | Sert GO 2ETH0
/] Request | End 070520181700
| Requested ° Manager Milan Stava Prag
7 Confirm Process 17-0013.01 Summer Revival Festival
Confirmed L Address Milan Stava Prag
< s < > <

>
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Activities at a glance
To see open and overdue activities at a glance, the Navigator, easyjob Today and the reminder
screen are available.

Navigator and easyjob Today

You can create various overviews in the Navigator and in easyjob Today. In addition to the
Check Address function ¥ (&), all open and overdue Activities * " (/) can be seen in the
General area. Birthdays &( ) can also be displayed. In the Personal area, you can display My
open and My overdue activities I5(2). To add overviews in the Navigator, click Settings %
and drag & drop the desired views to the left side.

My open workfiow approvals
My open Activities

All pastand not yet finalized Activities

07.05.2018 15:31
07.05.2018 15:18
07.06.2018 13:03
07.052018 11:00
07.05.2018 10:00
03.05.2018 00:00
03.05.2018 00:00
06102017 15:21
06.10.2017 14.22
06.10.2017 00:00
06.10:2077 00:00
06.10.2017 00:00
<

List | Overview

07.05.2018 15:31
07.05.2018 15:18
07.05.2018 12.03
07.05.2018 17:00
07.05.2018 10:30
03.05.2018 00:00
03.05.2018 00:00
06.10.2017 15:21
06.10.2017 14:22
06.10.2017 00:00
06.10.2017 00:00
06.10.2017 00:00

Advertising Media

Fax
Phene
Task
Task

Event attendance

Event attendance

Task

Phene
E-Mail
E-Mail
E-Mail

New customers action

Proposal Stage

Complain Invoive Missing tems
Meeting Project

Welcome CEQ

Invitztion

Invitation

Check budget

Problem Inveice

Job: 17-0013.01 Summer Revival Festival
Job: 17-0013.01 Summer Revival Festival

Project: 17-0117 Opening Central Station Prag
Invaice: 17-0020 Bon Jovi Tour 2017

£ Navigator (=N )
~ easyjob Start - End Type Name. Regarding Contact a
~ General " 07052018 16:25 (07.052018 16:25 Phone Check if the damage could be repaired  Workshop Activity: 17-0004 Service from Loading/Unlcac Audio Visual Service
i: :S:;f;gz;ﬂe 070520181622 07.0520121622 Appointment Advance booking follow-up model Item: 100775300 Christie CDXL-30 Abdullah Aaron
Check Address 07.05201816:07 07.052018 16:07 Fax Confirmation order Item: 10077 hristie COXL-30 A Rental Depot
Birthday 07052018 16:03 07.052018 16:03 Phene Room reserved Purchase 7-D006 Sub-hire 123 You're Hired Inc. Abdullzh Aaron
~ Personal 07052018 1603 070520121603 E-Mail Send list of members Purchase Order: 17-0006 Sub-hire 123 You'e Hired Inc. Alan Andersen

XY Event Productions -

Pro Projectors Assoc

XY Event Productions -

Milan Siava Prag

Prosound

ACME Prolnc,

XY Event Productions - Hans Schmith

Felix Georgallos

Prosound

Abdullah Azron - Abdullah Aaron

Abdullah Aaron - Abdulloh Aaron

Akim Alvarez - Aim Mlvarez v
>

Q=

The same information sources are available in easyjob Today and in the Navigator. You can
limit the period selection for Birthdays « using a Filter 2. To create your individual View in
easyjob Today, switch to the Setting mode j , select the desired Line Item and click Add View.

15 easyjob Today

Qheck Address

easyjob Today - Monday 7. Mai 2018

- Q

Own Number Cor

rthday °

@~

Start End Type

Regarding

o
%y overdue Activities 7

Start End Type

You can find a detailed description about customizing the settings for the Navigator view and
easyjob Today in the easyjob 6 User Manual.
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Checking an Address
Already created Addresses can be edited if necessary and marked as Checked in the Main Data

LI
7 1000003.00 XY Event Productions =] -E ]
MainDats Contacls Activiies Advanced Address Types Communicaion Invoicing Jobs SalesTrends ltem
Resowce Custom Fields DigiFlest TimeCard Time Ratings biz Qualifications
Enter general Address information here.
General Information

Company |x\’ Event Productions ‘

Company 2 [ |

Main Contact i

Strest [101 Sample: Drive |

Zip Code, City [B219 |[Dallas |

Country United States ~

Fhone [123-456-7892 |

Company Phone |12}555—DI}DD |

Fax [01234 saaea |

E-Mail [info@xyeverts com |

b [t/ www m biz |

Langusge v

Checked 0

Delete Save Cancel

Creator: Last Edited: Brad Casagni Brighton (06.10.2017 14:36) @

With the Check Address ® ® function in the Navigator or easyjob Today, all Addresses that were
not yet checked are displayed in a List &, from where they can be directly Edited S5 or marked

as Checked %6.

£ Navigator Q =[5 [k
v easyiob Mumber Own Humber  Company ~ MName | ”
v General 1001011.00 Zipp Production Jonny Cash Q -
z: Z::;rﬂ:;les 1000045.00 Youngstown Super Truss Rent adz Abbas E_dl" i
e 1000031.00 york Lighting Rental Adam Abdullzh Q fiilress chicked
Birthday 1000014.00 Winchester AV Distribution Adam Al Kadamani
~ Personal 1000035.00 wimmenau LX Ligh Shop David Albakri

My open workflow approvals | | 1000046.00 VALTSHIRE Theater Adrian Alberdi

Wy open Activtis 1000026.00 wilmington Music Thester David AlBinsli
1000021.00 wiilmington Concert Arena agus mude alcorn
1000013.00 ‘wilmington ALS Road Show Adrian alcantar
1000027.00 Wik bij Duurstede Crew Support  ahmad allen
1000022.00 \warsaw Concert Arena allene Araken
1000047.00 Vianen Theater Andrew balan
1000044.00 Valencia Quick Ligh Shop Andrew Bentzen
1000037.00 Upplandsvasby Music Theater David Beylier
1000015.00 Tucson Car Dealership Artur Blair
1000023.00 Trige Concert Arena ASHLEY Boshart
1000048.00 Torey ZINORD Theater Bart Bridle
1000028.00 Taren Point Crew Support Bill Burchell v

List | Overview 0
Addresses can be checked here

Checking Addresses with the Navigator view:

1. Click the Navigator Icon on the Toolbar

[ Settings icon

Drag and Drop Check Address to Navigation

Click the Settings icon to exit the mode

Select the desired address

> Right mouse button

[ Edit Address and then mark it as g Address checked

No ok o

The list will only show Addresses that were not yet checked.
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Birthdays
You can be informed automatically about birthdays. This View is available to you in easyjob

Today and in the Navigator. You can enter the birthdays under Contacts in the Address Main
Data

B Coreon B
MainData Advanced Activiies Commun icaion  Blocking Indicator CRM

Additional contact information could be created.

Contact_Field_1 [ ]

Contact_Field_2 [ |
[ Birtnday [107.05.1965 ||

Place of birth [New Yorc ] |

1.D. Card Nojvalid to [ |[O07052018 ]

Fassport No fvalid to [ |[Ooros2018 ]

Social security number | ‘

License Plate [ |

Save Cancel

Creator: Last Edited: Brad Casagni Brighton (07.05.2018 16:44) @

Entering a birthday in the Contact:

=

easyjob Menu o View > Address Book
Select an address

[ Edit Address

[ Contact tab

Select a Contact

[ Edit Address

[ Advanced tab

Enter the birthday

o> Save

© oN OO W

Displaying the birthday in the Navigator view:

1. Click the Navigator Icon on the easyjob Toolbar
2. P Settings icon

3. Drag & Drop Birthdays to Navigation

4. Click the Settings icon to exit the mode

Displaying birthdays in easyjob Today:
1. Click the easyjob Today icon on the toolbar

2. P Settings icon

3. SelectaLine Item and > Add View
4. Select Birthdays

5 p 0Ok

6.

Click the Settings icon to exit the mode
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Reminder Screen

] Activity - m] X

General  Attachments

Type [Task ] 1000003.00 Edit | | Del
Task T Follow- v = || XY Event Productions ~
- i % | Kordes Sanne
Name |Check # event un fine | A | 101 Sample Dive
| &8 | 75219 Dallas
Start 23052018 Time End[2305.2018 +|[11:00 | Time R
@ Phone: 0123 8888-21
Manager &, || Brad Casagni Brighton v Mobile Phone 01234 83889
e Company Phone  123-555-0000 v
Priority Normal v
Direction v

Outgoing
owain [0 @
perivcer  DB2E |63 ] Tme

Done O

Regarding  |17-0013 Summer Revival Festival | [X][Z][X

Text

9 B

Arial Jwo B zru HEEE EE A E Templt

Please double check if customer is happy with the order

Save 0K Cancel
Creator: Last Edited:

If you set a Reminder ¥ for an activity, you can have this activity displayed on the Reminder
window * * and specify the Reminder interval 8.

A Reminders

45 Reminders A
@c{ivities Reminder

Start End Type Name Priority Direction Manager Regarding Site Contact

07.052018 1542 07.052018 1642 Task Power supply check Normal Outgoing Clark Cafer Stockholm Project: 17-0009 Cityline Football Stockholm ACME Pro Inc.

My open Activities /'

Start End Type Name Regarding Contact

07.052018 16:25 07.052018 16:25 Phone Check if the damage could be repaired Workshop Activity: 17-0004 Service from Loading/Unloading process Audio Visual Service

07.052018 16:22 07.05.2018 16:22 Appointment Advance booking follow-up model ~ Item: 1007753.00 Christie CDXL-30 Abdullah Aaron

07.05.2018 16:07 07.05.2018 16:07 Fax Confirmation order Item: 1007753.00 Christie CDXL-30 AV Rental Depot

07.052018 16:03 07.05.2018 16:03 Phone Room reserved Purchase Order: 17-0006 Sub-hire 123 You're Hired Inc. Abdullah Aaron v
< >

9 Setings Qsmm. || Snooze

With Settings 95 you can select from among various reminder views.

@ User Settings X

General

Ac i
All overdue Activifies
All past and not vet finslized Activities

Reminders

My open Activities
Print My Activities to be finalized
My overdue Activiies
Synchronization || My past and not yet finalized Activities
My Activity Reminders
All my overdue Activities Reminders

Add || Delete

ok || Cencsl |

Activating reminders from the easyjob Menu:

easyjob Menu o Tools o User Settings

[ Reminders tab

o> Add

Select the desired settings and any filter options
2 Ok

a bk wd e

easyjob must be restarted to activate the changes.

34

© protonic software GmbH



CRM - Activities

Print activities

When printing a report (e.g. Proposal) in a project and in a Job you can automatically create an
activity. This creates a Print activity & in the Activity overview ¥ for the Project/Job " * with
various information such as the Print date, Address, Contact, Manager, etc. The relative PDF

document 5 will be saved and can be reopened at any time with Execute % or by double
clicking it.

) 18.000 7 Show = em
CostPlanner PostCalculation Fields
Actualhowrs Rooms Report Parametes OBUs

MainData Overview Add Appoi il Activities Planning B Job Costs A

Workflow Rating Web access R Time R dir
All Project éitiwties ates displaed here
Project I TC Show - Main Items

stat|] &/ 22018 ~] End[M] 7152018 ~] Manager [ ||| Brad Casagni Brghton

ITC Show - Lacation B ITC Shaw - Location © Sub-hire Speedrental MyPartner

[ Include Groups

Kepond |1 Oniy uning Activities [ Display all connected activities

Start Erd ey v— Tantact Nome Proily  Diection  Manager Fralzed Fralzed by

EA5/2018 6/15/2018 |4 XY Event Productions Printed Momal Outgoing  Brad Casagni Brighton Brad Casagni Brighton
Add Edi Delete

ttachments
6Llst Preview

Description  Name

jectPoposalt | [15-00

0:
Scan Q—Execute

Travel Sub-Rental Overview To Outlook Resources Items Cloze

Creator: Brad Casagni Brighton (B/12/2018 .24 PM)

Last Edited: Brad Casagni Brighton (6/15/2018 12:47 &M (;)

Activating automatic print activity creation:

1. easyjob Menu o Tools o Settings
2. Select the CRM tab

3. Check the Create print activities box
4. P Ok

easyjob must be restarted to activate the changes.
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Connected activities
In order to be informed in a project about all of the CRM activities related to this project, you
can use the function Display all connected activities. If this selection has been activated, all

activities for the relevant Purchase orders ¥, Invoices & and Workshop activities ** will be
displayed in the Job activities.

15,000 7C Show s
Main Data Dverview Add Appoi R Activities Planning R Job Costs A h CostPlanner PostC. ion Fields
Puich Workflow Rating Webaccess R Time R ding Actualhours Rooms Repoit Parameter DBUs
Zeigt alls Quslfizienngen 2u Fessourcen
{I"Projectt 11 ITC Show - Main Items [ ITC Show - Lacation B || ITC Show - Lacation © | Gubhire Speedrental MyPartner
Stat[] 6/ 22018 ~] End[[] 7152018 ~] Manager [] ||| Brad Casagni Brghton [ Inchude Groups
Keypword ‘ ‘D Only runining Activitiss ed a_ct\vll\es“;
Start End Type Address Contact MNamne Direction  Manager Finalized  Finalized by
6A15/20M8 615,28 [ 27 Event Productions xplain damage and costs Mormal  Outgoing  Milan Slava Prag
6A15/2018 BA5/20M8 g A Rental Depot urchase Dider faxed Normal  Outgoing  Milan Slava Prag O
B/742ME 57208 B 7 Event Productions al:ump\ainlnvnive Missing Iterms ~ Normal  Incoming  Brad Casagni Brighton O
Add Edit Delete
Attachments
List  Preview
Mame Description  Mame  Path
Scan
Travel Sub-Rental Owerview To Dutloaok Resources Items Close
Creator: Brad Casagni Brighton (B/12/2018 5:24 PM) Last Edited: Brad Casagni Brighton (6/15/2018 12:47 &M (;)

Activating all connected activities:

easyjob Menu o View o> Projects

Select a project

o Edit

[ Activities tab

Check the box for Display all connected activities

gk~ wbd =

Quick Change of the Address in the Project
If an activity is created in a project, the project customer is automatically preset. Via the

address selection Quick Change function, you can display all Addresses present in this project
to use them for a new activity.

[3] Activity _ o %

General  Attachments

Tipe [oportre | 1000300 £a| [ 0el | [=]

Name. [ | XY Event Productions

Start 6152018 | (0150 AM | Time  End[ 6/15/2018 +|[01:50 AM | Time | g | 101 Sample Drive uctior

Manager | & [Mian Sava Prag v Sja »

v = Prone 013 e Resources »|[ 18000801 ITC Show - Main Items »|

Piiily Nomal Moble Phone 01234 88839 Alan Andersen
Dirsction’ | Glizok v Company Fhone. 1235550000 =S 18-0008.02 ITC Show - Location B »
Duration 0] O 18-0008.03 ITC Show - Location C »

Reminder (][ 6/15/2018 - ||06:50 AM | Ti 18-0008.04 Sub-hire Speedrental MyPartner  »

Done |

Regarding 180008 1TC Show |_RIZ1[X

Text

¢ @am

Arial o - Bz U =SEH== EE A- @A Templte

s oK Concel
Creator LastEdited:
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Activities in the WebApp

Information from CRM can be viewed and managed using the easyjob 6 WebApp.

Dashboard

The WebApp Dashboard provides you with an overview of your activities. In the calendar over-

view, you can see the Activities ¥

scheduled for the day and can open and edit them. Your

open activities are displayed under Important * . Activities are indicated with an A &. Your
activities are also displayed under Today 95 and From today %b.

= Dashboard
July 2018
Fri Sat Sun Mon Tue Wed
¢ Q 6 7 8 9 10
Task Ch...
i 18-0008 ITC Show
Important @

Problem Invoice Phone
Prosound

Welcome CEQ Task

Prosound

Complain Invoive Missing Items Phone
XY Event Productions

Proposal Stage Fax

Pro Projectors Assoc.

New customers action Advertising Media
XY Event Productions

Today @)

ITC Show 18-0008

18-0008 ITC Show E-Mail

XY Event Productions

From today €}

Check budget Task

Felix Georgallos

ABC Product Lounge Part 3 18-0001

11

Thu

12

v

¥

>

W

W

To edit an activity, tap it and you can change the start and end time &, the Manager ./ and
the Address , mark the activity as Done ) and save your entries 3.

— £ Dashboard

Activity Type Task

Task Type Check budget limit

Name Check budget

Start Date Jul 6, 2018 3:00 PM

End Date Jul 6, 2018 3:15 PM

Manager Brad Casagni Brighton

Process 17-0117 Opening Central Station Prag
Edit

Finalized O a

Save

e
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Activities
With the WepApp Menu ¥ you can switch from the Dashboard * * to Activities 8.

Dashbadg

June 20
Fri Sat Sun Mon

15 16 574 al

18-0008 ITC

Important

A Problem Invoice Phone
Prosound

Check budget Task

Felix Georgallos

Welcome CEO Task

Prosound

Complain Invoive Missing Items P
XY Event Productions

Pro Projectors Assoc.

New customers action Advertising
XY Event Productions

A Proposal Stage Fax

A Room reserved Phone
Abdullsh Aaron

A Send list of members E-Mail

Alan Andersen

There you can Edit activities 95 or Add new activities %b.

= Activities er

]
K+
Problem Invoice Phone
Prosound

Check budget Task

Felix Georgallos

Welcome CEO Task

Prosound

Complain Inveive Missing Items Phone
XY Event Productions

Proposal Stage Fax
Pro Projectors Assoc.

New customers action Advertising Media
XY Event Productions

Room reserved Phone
Abdullah Aaron

Send list of members E-Mail
Alan Andersen

Confirmation order Fax
AV Rental Depot

Advance booking follow-up model Appointment
Abdullah Aaron

Check if the damage could be repaired Phone

Audio Visual Service

Presentation of new products Phone

Spring-Special E-Mail
XY Event Productions
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Address Book

The Timeline ¥, all the activities assigned to the Address * * and the CRM Advanced & infor-
mation is available in the Address Book.

= 1000003.00 XY Event Productions e

Company v
Company XY Event Productions
Address 101 Sample Drive
75219 Dallas
Fax 01234 88889
Phone

123-456-7892

E-Mail

info@xyevents.com

Contact
Timeline @ ¢

Monday, July 2, 2018

18-0008.02 ITC Show - Location B

Friday, June 15, 2018

12:06 AM - 18-0008 ITC Show
Thursday, June 14, 2018

11:42 PM - 18-0008 ITC Show

Friday, June 1, 2018

10:00 AM - Spring special as well
10:00 AM - Newsletter June for all L-Customers
Last minute

18-0008.01 ITC Show - Main Items

Tuesday, May 29, 2018

3 2:30 PM - Customer question about proposal

10:00 AM - 18-0007.07 Sub-Rental ABC Product Lounge Part 3

Activities @)

CRM &)
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Project management

In Project Management, in addition to the project or job related activities, it is also possible to
collect and evaluate CRM relevant information (probability, cancellation reason, etc.).

Probability

When creating a Project or a Job, you can assign a probability to it.

[} 17-0021 Project Future o[-
MainData Dverview Add Appoil R Actlivities Planning R Job Costs A hi CostPlanner
PaostC. ion Fields Puich Workflow Rating Web access R TimeR ding Rooms ReportParametes OBUs
All information necessary for a praject can be recorded.
Praject || Project Futwe ' Big Opening
Main Data Delivery Address/ Yenue
Job Name [Big Opening | 1000003.00 Edit | | Del
Job Number [170021.02 ]| | XY Event Productions ~
Reference Number | ‘ o 101 Sample Drive
75219 Dallas
Manager £, | Brad Casagni Brighton ~ @
2+’ | Phone: 123-555-0000
Status ® Rental O Sub-Rental (O Sales Mu?:l;:z Phone 01234 23239
Proposed ~
Mates |
Site Stockholm ~ 5
Servica
FERHEIE fEcoe @ Customer Fickup () Resources orly
Company Standard ~ (O Deliver ltems O Full-Service
Delivery type ~ Motes
Schedule Informatiorn
Start 1152021 ~ ‘12 00 AM | Time
End 37152021 |[1200 AM | Time
Calendar D ays Drays Used
[ Period
Dffer walid through 6/20/2018
Total £0.00
Available 1 Daylater [
Nat to invoice [
Frababilty y
Wy,
Travel Sub-Rental Overview To Outlook Resources Items Close
Creator: Clark Cafer Stackhalm (3/16/2017 10:34 AM) Last Edited: Clark Cafer Stockhalm (3/16/2017 10:36 AM) \'j)

Entering the probability:
1.
Select a project

2 Ok
> Main Data tab

a bk~ wbd

Enter the desired probability

easyjob Menu o Projects g Edit Project

You can assign a probability only to Projects and Jobs with a Proposed status.

The probability is displayed, for example, in the Project/Jobs View. The entries can be evaluated
in the easyjob Business Information Center.

[ Projects - O 'Y
Fram Rertsl  []SubPentsl [ Sakes  Tope <Al =

To Proposed Confimed  [] Canceled  Priority | <All> %

kepword | | Site | Stackholm, Prague, Brighton v

Customer | [ (B3¢ Manager [ i

Mumber  Name Start Date End Date Priority  Manager Status Customer « Site Project Tatal I;mbablllty 1
17-0012  Summer Revival Festival 1212017 3.00 AM F46/201811:00 PM MNommal  Cafer Clark Confirmed ¥ Ewent Productions  Stockholm €13,000 UD‘: 70.00%
18-0008 ITC Show 6/1/2018 12:00 AM F31/201812:008M  Nomal  Milan Slava Confimed ¥ Ewent Productions  Stockhalm £3.370. 58% 70.00%
18-0001  ABC Product Lounge Part 3 943/201810:00 AM 9/10/201810:00 PM  Mommal  Milan Slava Proposed Y Event Productions  Stockholm  €114.674.65| O DDZ)

Cancel
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Cancellation reason

When a Job or Project is Canceled, you can enter the cancellation reason for future evaluations.
Cancellation reasons include Proposal variation (if you created multiple Proposals at the same
time for the same Request), Project Canceled, Unknown, Lost to other customer (if, for
example, another agency for which you are a subcontractor received the order — in addition you
can add the new, confirmed project) or Lost to competitor (in this case, you can enter the
competitor). In all cases, you can enter a remark. The information you entered is displayed with

[} 18-0004 2BC Product Lounge Part 2 = ]
Main Dats Overview Addresses Appointments R Activities Planning Rs JobCosts Attachments CostPlanner PostCalculation
Fields Purchase Invoices Workflow Rating Web TimeR ding Rooms Report Parameter OBUs
All information necessary for a project can be recorded

Project || Get Together || Mesting || Media Rent Sub-hire || Missing ems: Get Together

Main Data Delivery Address/ Venue

Job Name 1001012.00 Edit | | Del |

JobNumber  [18:000401 ] | Best Westem Hotel ~

" | Dave Johnson
Reference Numberl | Canal Srreet 75
78022-0280 Live Oak County
Manager £ | Brad Casagni Brighton > .
i = = " Phone 123456789
e Company Phane 123456789 I
Canceled ~
| —~— | s
Site Stockholm Lost to competitor
Dumping

Return Site Brghten Competitor: AV Rental Depot

Company Standard e 5

Delivery type v Notes

Schedule Information 4

Start 04052018+ |[08:00 | Time

End 7052018~ Time

Calendar Days Days Used

| @ Period "
< >
Travel Sub-Rental Overview To Outlock Resources ltems Close

Creator: Brad Casagni Brighton (08.05.2018 09:54) Last Edited: Brad Casagni Brighton (08.05.2018 09:58) (¢7) @

Canceling a Project/Job:

1. easyjob Menu o Projects g Edit Project
Select a project

2 Ok

Select a Job if necessary

[ Main Data tab

Set the status to Canceled

Status Change Reason K

o oA W

A reason for the status change must be specified.

Reason | Lost to competitar v

poes Lost to competitor

Lost to other customer
Project Canceled
Proposal variation
Unknown

0K Cancel
7. Enter the reason and any other information

8. p Ok
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Credit Limit in the Project

If you have set a Credit Limit in the Address Master Data, this will be displayed with the
amount of the Credit Limit and the sum for Open Entries and the sum for currently Confirmed
Jobs.

[) 17-0013 Technology Center Sound
MainDats Ovenview Addresses Appointmenis Resources Activities Planning Resources JobCosts Attachi Cost Planner PastCalculation Fields
Purchase Invoices Workflow Rating Webaccess Ri Time Rooms Repori Parameter OBUs

All information necessary for 2 project can be recorded,

Project || Technology Center Sound

~

Main Dats Customer

FrojectName  [Technology Center Sound | 1000008.00 Edit | | Del

Project Number  [170013 || | | Dsmolight Co
“" | Lamy Lopez
Reference Number | ‘ m Milion Dollar Mile
12345 Dallas
Manager £, | sys admin ~

The Address is locket

Status Proposed v Credit Limit: 5.000,0 '5.000,00". Open entries '0,00', Confirmed jobs '3.469,00"
Priority Nomal ~ eMail:
aheinrichFl @demo easyjobx com
Type v Web hitp:/ /w1 biz
Site Stockholm ~ otae
Base Currency EUR
QOutput Currency | EUR ~
— [ i
Travel Sub-Rental Overview To Outlock Resources ltems Close
Creator: sys admin (22.01.2012 16:26) Last Edited: [D

A warning is displayed in the Job and the Cost Planner if the Total exceeds the Credit Limit.

[ 07-0013 Technology Center Sound
MainDsts Overview Addresses Appointmenis Resources Activifies PlanningResowces JobCosts Attach Cost Plamer PostCalculafion Fields
Purchase Invoices Workflow Rating Webaccess R Time Rooms Report Parameter OBUs

Here you can analyze the profitability of your Project/Job.
Project || Technology Center Sound

Income  Expenses Profit @

“Jens
“ Rosoos
oste
Roors
oo

Subtotal 1.564,80 € 1.256,00 €
[l Total 1.564.80 €| | 1,

The Address is locked for:

Total calculated o s =
Credit Lir 10,00 € of '5.000,00". Open entries '0,00', Confirmed jobs '5.032,80"
Tax | Worldwide b 100,
Travel Sub-Rental Overview To Outlook Resources ltems Close
Creator: sys admin (22.01.2012 16:26) Last Edited: Brad Casagni Brighton (08.05.2018 10:06) (¢7) @

See also ¥ Credit Limit Blocking Indicator.
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Address Master Data

You can enter a wide range of information for an address in the Address Master Data. CRM
fields are available on the Master Data ¥, Contacts " *, Activities &, Blocking Indicator 95,
CRM %, CRM Advanced &, Agreements ./ and Relationships  tabs.

oy .00 nt P ions E@
MainData Cﬁ R Advanced Address Types Communication Invoicing Jobs SalesTrends Iltem Resouwrce CustomFields Attachments DigiFlest
TimeCard TimeRecording Ratings rentalmarketbiz Qualifications Blocking Indicalor  Purchase Invoices CRM CRMAdvanced Agresments Relationships
Enter general Address information here.
General Information

Number Own Mumber Picture

Company [ Event Productions |

Company 2 | ‘

Main Contact Kordes Sanne ~

Strest [101 Sample Drive |

Zip Code, City [75219 |[Dallas |

Country United States -

Phone |123-'15&7352 |

Company Phone [123-555-0000 |

Fax [01234 83889 |

E-Mail [info@xyevents com |

\leb [Pttp://weswe m biz |

Language -

Checked

Delete Save Cancel

Creator: Last Edited: Brad Casagni Brighten (07.05.2018 17:00) @

Main Data
See ¥ Checking an Address.

Contacts

For Contacts, you can enter information such as the Title, Source, Recommended by,
Acquisition channel and the Newsletter Status.

& Contact - O 'Y
MainDats Advanced Activiies Communication BlockingIndicatr CRM

Advanced CRM data can be entered here.

Title [Professor |

Source [Personal cortact duing Opening After Show |

R by [V Rertal Depot Thomas Masterson |

Acquisition channel Campaign v

|0pen\ng city stare | Q|| X
Newsletter Status Invited ~
ok || Corce

Creator: Last Edited: Brad Casagni Brighton (08.05.2018 10:16) @

Entering CRM information for a Contact:

1. easyjob Menu o View > Addresses
Select a Contact o Edit

I CRM tab

Enter the information

o> Save

a bk wb
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You can assign specific activities to the Contact and enter a Blocking indicator.

Entering activities for a Contact:

1. easyjob Menu o View > Addresses
2. Select a Contact o> Edit
3. P Activities tab

& Contact - O 'Y

MainData Advanced Activiies Communication Blocking Indicatn CRM

All Activities for an Contact are displayed here.

Start (101052018 +| End[107.062018 +| Manager [ | || Bred Casagni Bughion [ Include Groups

Keyword | | &2 Only running Activities

Start End Type Name Priority Direction Manager Finalized ~

23052018 29052018 3 Customer question about proposal ~ Normal  Incoming  Brad Casagni Brighton

23052018 23052018 [ Check if event run fine Mormal Outgoing Brad Casagni Brighton O

03042017 03042017 ¥ Invitation Normal Outgoing Clark Cafer Stockholm O

30.03.2017 30032017 Y Invitation Mormal Outgoing Clark Cafer Stockholm |

30032017 30032017 Y Invitation by mail Normal Outgoing Clark Cafer Stockholm O

26.01.2017 26.01.2017 Invitation to event trade show Mormal Outgoing Clark Cafer Stockholm O v

< >
Add Edit Delete
Save 0K Cancel

Creator: Last Edited: Brad Casagni Brighton (08.05.2018 10:16) @

4. Create the desired Activities
5 po Save

Activating a Blocking indicator in the Contact:

1. easyjob Menu o View > Addresses
Select a Contact

o Edit

I Blocking Indicator tab

Enter the desired Blocking indicators

& Contact - O 'Y

ok~ w

MainData Advanced Activibes Communicaion Blocking indicsin CRM
Block indicators can be stored here.
Blocking Indicator

[[] Dezctivated

[ E-Mail

Phone

sme ([ ]| cnen

Creator: Last Edited: Brad Casagni Brighton (08.05.2018 10:16) @

6. o Save
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Activities

Here you can find an overview of the activities assigned to this Address See also F Activities in
the reference type.

Blocking indicators

Blocking indicators are available on an address and contact level. With a Blocking indicator,
you can block various activities for this Address. For example you can block the creation of a
Reminder or limit the CRM Communication channels for the respective Address or Contact, if
the customer does not want to receive e-mails in general or does not want to be called.

& 8
Aligemein  Dokumente Algemein  Dokumente
| i [Enai 100000300 Bea | | Entl

Tye Telefon ]
Bezeichrung [frfrage [ XV Event Productions. ~ Bezeichrung [Frage ob iteresse an Adfiag
Datum 16032017 ][ | um A | Frerkluter Landsiasse 143 Datum 20207 v][__ | um
63452 Hanau
Beabeiter | & Admin admn v @) Beabeter | £ || Admin admn v
] CRM Eigeniiner aus Adresse verwenden N [ Piotit | Nomal 7
Pioitat Nomal v Joleor Phsat:- /01234 55088, s Richtung | Ausgehend v
Richtung | Ausgehend v Daver 19
| Daer 0® / Einenng (] [2703201 500 | Uhr
Eimenng  [[16.052017 o Eledgt  []
ol Sperrkennzeichnung / X = Spenkennzsichnung
Ededgt o Betit Telefonabirage
Die Adresse XY Event Productions st gesperr fur Email senden’ Die Adresse XY Event Productions st gesperrt far “Anrufen’
Beift Tex
o 9 BEY
2c @by DY| [ A i
Aral - B 7 U S S I A W% Vahlen
Hallo, ol
hiermit laden wir Sie herzlich zu unserem Sommerfest am 22.07.2017
nach Frankfurt ein
v
Speichemn ok Abbrechen Speichem 0k Abbrechen
Angelegt. Adrin adin (27.03.2017 10.07) Beabeiet. Admin admin (27.032017 1008) Angelegt: Admin adrin (27.03:2017 1013)

Beabeiet

If you have activated a Blocking indicator for a customer, a symbol ¥ will appear in the
address field. With the left mouse button, the name of the Blocking indicator and the reason
for the block * * are displayed. If an attempt is made to perform an activity (e.g. Confirm Job)

for which a Blocking indicator has been set, a dialog window opens and the activity cannot be
carried out.

[ 18-0003 Festival Opening o 2|
Main Dat Overview Adds i R Activifies Planning Job Costs CostPlamer PostCaleuliion Ficlds
Purchase Invoices Workflow Rating Web References TimeRecording Rooms Report Parameier OBUs

All information necessary for @ project can be recorded.

Project || Festival Opening

Main Data " Customer

Prct e ot 00 g (oo [

Project Number  [18-0003 & | XY Event Productions ~

ReferenceMumber | | 101 Sample Drive

T 75219 Dallas
Merages: & | 2 The Address is locked for:
Status Proposed ~ ‘Confirm Project/Job’
Resson of block:

Friority Nomal Dl s

Type . - T v

Site Brighton Blocking Indication e X

Base Curency  |C2K

Otk Cirrency c7K The Address XY Event Productions is locked for ‘Confirm Project/Job’,
Sehedul nfornaion

Start 18042012 [ 00

End [ 20208 [ 0000 Time

Travel Sub-Rental || Overview || ToOutlook | | Resources tems Close.
Creator: Milan Siava Prag (09,04 2018 21:19) Last Edited: Brad Casaani Brighton (08 052018 1022) @
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CRM - Address Master Data

Credit Limit Blocking Indicator

You can enter an individual value for the Credit Limit Blocking Indicator. If a customer is
selected for a new project, the sum of the open entries and the sum of the confirmed Jobs is
added and you will receive a corresponding message. See also ¥ Credit Limit in the Project.

Blocking indicators in an Address
Activating Blocking Indicators for an Address:

1. easyjob Menu o View > Addresses
2. Select an address

3. pPo Edit

4. o Blocking Indicator tab

) 1000003.00 XY Event Praductions - O 'Y

MainDats Contacls Activiies Advanced AddressTypes Communicstion Invoicing Jobs
Sales Trends liem Resouwce Custom Fields hi Blocking Indicator

Block indicators can be stored here.

Blocking Indicator
[] Deactivated
[] Assign project customer
Confirm Job/Project
[ LoadiCheck-Out Job
[ Create invoice
[] Create reminder
[] Create Purchase Order
[ Create sales order
[] Assign Resource

[ Credit L\mlt

E-Mail

[] Phone

Reason of block

Unpaid Invoice

Delete Save Cancel
Creator. Lest Edited: Brad Casagni Brighton (08.05.201810:22)  (3)

5. Enter the desired Blocking indicators
6. o Save

Blocking indicators in a Contact
See T Contacts.

Deactivate address

You can also deactivate individual addresses. The Address can no longer be selected. Any
Activities in which the Address was used prior to deactivation will remain saved. You can
assign separate user rights for deactivation and for viewing Deactivated Addresses.
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CRM - Address Master Data

CRM
The CRM X tab provides you with an overview of the CRM Owner **, Industry &
(Supplier/Stand builder/etc.), Parent address b (if the customer is a subsidiary), Marketing Lists

% in which the customer is a member, Subsidiaries & this customer owns and Campaigns /
in which the customer was involved or will be in the future.

@1

uﬂmmmmmmm&ﬂmmmmmmwm
= Rati i Qualificaions Blockinglndicalr Purchaselnvoices CHM  CRMAd } R S i
Select a Time Frame to view Sales Trends here. &
RMOwner | Mian Slava Prag v| I&y[&lﬂw | [1001030.00 Procetion Inc. |21 [X]

ting Lists
Name Description _Filter

Best wishes List ( Address Type.Name = Customer M)
Customers with low Projects ( Address.Number_confirmed_Projects < 1 Start 08.05.2018 to 08.05.2018)
Main Customers

add || Edt

Type  Number Company Company 2 Salutation FirstName Middle Name LastName City  State Country Phone Company Phone Home Phone  Web
Address  1001016.00  Meeting Today Hello Thomas Fox Dallas United States  1.877.699.8866  1.877.699.8850  1.877.699.8878  http://www.rm.biz

Start End
01.01.2017 1420 | 15.04.2017 14:20

Summer Party Event  Event for potential customers 30.03201710:21  06.04.2017 10:21
Summer Special 10 % discount 29.03.2017 14:13  05.04.2017 14:19

~ ad | Ew |
| e || swe [0k ] concel |
Creator: Last Edited: Brad Casagni Brighton (08.05.2018 10:30) @

In this overview, you can Add Marketing Lists and Campaigns or Edit already existing ones. The
Address Master Data for the Subsidiaries can be edited.

Making CRM entries for an Address:

1. easyjob Menu P> View > Addresses
Select an address

o Edit

2 CRM tab

Enter the desired content

o> Save

o 0k wN

CRM Owner
The Address can be assigned to a user. This is the Employee that takes care of this customer
from a CRM point of view. With entry, filters can be created, for example.

You can assign a right for Change Foreign Owner in the ¥ User settings. If this right is not
activated, Addresses and Contacts cannot be assigned to other users.
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CRM - Address Master Data

Industry

The multi-level industry selection makes it possible for you to split suppliers between event
agencies and stand builders, or divide the federal government into different states, and these in
turn into municipalities. You can evaluate the entries in various areas (easyjob Business
Information Center).

Creating an industry selection:

1. easyjob Menu > Master Data g Industries
2. P Add
[ industries =E=EE=]

3. Create the industry level separately with the backslash
4. P Ok

Parent address and Subsidiaries

In order to better display the group structure, you can assign a Parent address ¥ to each
Address. The assigned Address will be automatically displayed as a Subsidiary ** in the CRM
address tab for the parent address.

MainData Contacls Activilies Address Types  Ce ication Inveicing Jobs SalesTrends Item Custom Fields DigiFlest
TimeCard Time Ratings biz Qualifications Blocking Indicator Purchase voices CRM CRM onships  Web
The Marketing Lists and Campaians that contain the Address are displayed hers

CRM Owner | Mian Slava Prag | Industry [Eventagency Parent 1001030.00 Procetion Inc. ° [A2][X]
Marketing Lists

Name Description_Filter

Best wishes List ( Address Type Name = Customer M)
Customers with low Frojects [ Address.Number_confirmed_Projects < 1 Start 08.05.2018 to 02.05.2018)
Main Customers

Add Edit
Subsidiarys
Typs  Mumbsr  Company Salutstion First Name Migdle Hsme LsstName City  Country Phors Company Phore Home Phone  Vish
Address 1000209.00 Genius EventsCZ ~ DearSir  Fisher Georgiou  Prague  Czech Republic (248) 104 3242 bt fhwwws.rm biz
Address 100101600 Mesting Todsy Hello  Thomas Fox Dallas  United Ststes 18776208866 18776598850 18776398878  hitpiwww rm biz
Address 100003000 Poriand Crew Support Francis Gilbert  Portland (365) 207 6553 hitghwwew.rm biz
< = 4
. Foma 3
G ad
Dete || swe |[ 0K || cancel |
Creator: Last Edited: Brad Casagni Brighton (02.05.2012 10:37) 6]

Assigning the parent address:

1. easyjob Menu o View > Addresses
Select an Address o Edit

I CRM tab

Assign the parent address

o> Save

a bk~ wb
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CRM - Address Master Data

Also the Contacts for the subsidiary can be displayed in the Contacts for the parent address.

ZipCode City __ Company
75219 | Dallas
Management Head HR 75218  Dallas XY Event Productions
0177888888 01238888-13  hschmith@xyevents.com _Sales CEO 75219 Dallas XY Event Productions
Francis  Gilberl (865 307 1000 (B65) 307 4634 (865) 307 4620 FR@web.com Poriland Portiand Crew Support
Thomss  Fax 18776998350 1877639.8378 1877658.8850 18776388850 Dallas@monster.com Dallas  Mesting Today
Fisher  Georgiou (248) 104 3114 Prague  Genius Events CZ

[] View Subsidiary Contact | [ ] Display deactivated

L = =

=5 ol )
Ratings iz Qualificaions  Blocki Purchase invoices CRM CRM ionships W teport Parameer

 Add addtional Contacts here.

Contacts

| Dl || swe [0k ] camce |

Creator:

Last Edited: Brad Casagni Brighton (02.05.2018 10:37) @

Displaying subsidiary contacts:

6. easyjob Menu o> View > Addresses
7. Select an Address o Edit

8. o Contact tab

9. Check the View Subsidiary Contacts box

Marketing Lists

In order to carry out campaigns, you can create marketing lists for certain target groups in the
Master Data. The CRM address tab shows which Marketing lists ¥ the Address belongs to.
See also F Marketing Lists.

MainDain Conlacls Activiies Advanced AddressTypes Communicafion Inveicing Jobs SalesTrends liem Resowce CuslomFields Attachmenis DigiFlest
Time Card Ratings I tbiz Qualifications  Blockin P Invoices CRM  CRM Ads tionships  Web
The Marketing Lists and Campaigns that contain the Address are

CRMOwner | Mian Slava Prag | Industry [Evertagency [~] Parent 1001030.00 Procetion Inc: A2 X]
Maha'ling\_istsg

Name Description _Filter

Bestwishes List { Address Type Name = Customer M)
Customers with low Projects ( Address Mumber_confirmed_Projects < 1 Start D8.05.2018 to 02.05.2018)
Main Customers

Type  Number  Company Salutation FirstName Middle Name LastName City  Country Phone Company Phone Home Phone  ieb

Address 100030800 Genius Events CZ DearSir  Fisher Georgiou  Prague  Czech Republic  (248) 104 3242 ittp v rm iz
Address 100101600 Meeting Today Helle Themas Fox Dalles  United States 18776998865  1877699.8350 18776998278  hitwillwwwrm biz
Address  1000030.00  Portland Crew Support  Dear Sir  Francis Gilbert  Portland (865) 207 6553 htp:fhwwrws.rm biz
< >

Description Srt End

Early Bird 5% disoount 010120171420 15042017 14:20
Low project activation Give all customers with low project a phone call  26.01201518.26  02.02.2015 18:26
Opening city store 030420171119 10.042017 11:19

Event for potential customers 3003201710:21  06.04 2017 10:21
10 % discount 29.03.2017 1419 05.04.2017 14:19

| pelete || save [ ok || cancel |
Creator Last Edited: Brad Casagni Brighton (08.05.2018 10:37) @

Campaigns
All Campaigns * " in which the customer was involved are displayed here. Additional

campaigns can be added or already existing campaigns can be edited. Additional information
can be found in F Campaign.
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CRM - Address Master Data

CRM Advanced

You can enter additional information about the address on the CRM Advanced ¥ tab. With
details such as Status " " (Cold, Warm, Hot, Not interested and Qualified*), The next big thing
& (the customer's next large project), Source S5 (where the information comes from), who the
customer was Recommended by %o, Preferred Contact Method & (E-mail or Phone), Number
of Projects per year ./, Project budget per year , Income ), No. of employees 2,
Acquisition channel § (e.g. a campaign and its name &) and the Newsletter Status f
(Invited, Subscribed and Denied), your sales team is able to record, evaluate and use important
information about this customer.

® 1000003.00 XY Event Productions [oe]==
MainData Contacts Activiies Advanced Address Types W Jobs
SalesTrends ltem R CustomFields Attach, CRM CRM Advanced

Advanced CRM information can be displayed here.

Q Status Cold v

Cold

Wam

Not interested

i Qualfied

€3 The next big thing [Word-Tour 2020 ]
L78 Source {Personal contact during Opening After Show ‘
L3 Recommended by [AV Rental Depot Thomas Masterson ]
6 |

¥ Number of Projects per year

©

Project budget per year 1.250.000.00

Preferred Contact Method | Phone: v
E-Mail

[ Income 100.000.00
B e ctervises @
Acquisition channel Campaign v
Nowirwr (B |x
£5) Newsleter Status [invited <]
Invited
Subscribed
Denied
Delete Save Cancel
Creator: Last Edited: Brad Casagni Brighton (08.05.2018 10:51) (1)

Making CRM Advanced entries for an Address:

1. easyjob Menu o View > Addresses
Select an address

o Edit

2> CRM Advanced tab

Enter the desired content

o> Save

o ks wN
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CRM - Address Master Data

Agreements

Another option for documenting your customer relationships is available on the Agreements ¥
tab. Master Agreements, Letters of intent, etc. can be documented and managed here in a
clear manner. An Overview " * shows the topic, a description as well as the start and end of
the agreement. With the Show Inactive & filter, you can display agreements that are no longer

active 5. With Add %6 you can create a new agreement.

are displayed here.

Show Inactive

bject Description Start End Active
Letter of intent cooperation until 2018 16.03.2017 31.12.2018 M
Master Agreement 10 % discount for minimum 100.000.00 EUR turnover per year  01.052017 02052019 [
Master Agreement 8 % discount for minimum 100.000,00 EUR turnover peryear 16032016 17.032016  [J

Creator: Last Edited: Brad Casagni Brighton (08.05.2018 10:51) @

® 1000003.00 XY Event Productions
MainData Contacts Activiies Advanced AddressTypes Communicaiion (Wlicicing Jobs
SalesTrends ltem Resource CustomFields Attachments DigiFleet Agrecments Relationships

In addition, you can add Attachments & for the agreement. The corresponding documents are
shown in a List ./, which can be opened by double clicking them or by pressing Execute .

Agreement b a X

Subject [Letter of intent

|

Description ’coopemion until 2018

Start [116.03.2017 v

End 1131122018 +
Attachment
List  Previ

Name Description Name

LetterlOfintend | 2017-2018 | LetterlOfintend.pdf

Scan Ordner  ® Execute | P i Edit Delete

0K Cancel

Creator: Clark Cafer Stockholm (30.03.2017 11:07) Last Edited: Clark Cafer Stockholm (30.03.2017 11:07) @

The selected Document ¥ is displayed in the Preview ).

Agreement — [m] X

Subject [Letter of intent |
Description |ooopetaﬁon unti 2018 |

Start [116.03.2017 +

End [1131.122018 +
Attachmen!
List Preview
AanyCanry.
.
o
[
] Scan || Ondner || Execute Edit Delete
OK Cancel
Creator: Clark Cafer Stockholm (30.03.2017 11:07) Last Edited: Clark Cafer Stockholm (30.03.2017 11:07) @
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CRM - Address Master Data

Creating agreements for an Address:

1. easyjob Menu o View > Addresses
Select an address

o Edit

2> Agreements tab

Enter the desired content

o> Save

SIS AN

In F User settings you can assign a right to View and/or Edit Agreements.

Relationships

Addresses that have a particular relationship with each other can be recorded in the Address
Master Data on the Relationships ¥ tab. You can define the type of relationship (e.g. Supplier,
Customer, Partner, etc.) * " in the Master Data. Create a new relationship with Add 8.

|
N\ /7
_@_
=
-

1®1 1000003.00 XY Event Productions o |-G ]
MainData Contacls Activiies Advanced AddressTypes Communicafion Invoici Jobs rends  ltem
R Custom Fields DigiFleet TimeCard Time Relatitnships
Addresses can be categerized under multiple Address Types,
MNumber Own Number Company Relationship Type From number Of Own Mumber From company
1001019.00 Prosound Customer 100000300 200500701 XY Event Productions
1000010.00 Big Events Inc. Supplier 1000003.00 800500701 XY Event Productions
1000033.00 SOLA Lighting Rental  Partner 1000003.00 200500701 XY Event Productions
1000003.00 200500701 XY Event Productions  Customer 1000030.00 Portland Crew Support
9 .
Delete Save 0K Cancel
Creator: Last Edited: Brad Casagni Brighton (08.05.2018 10:51) [D

Creating relationships for an Address:

1. easyjob Menu o View > Addresses
2. Select an Address o Edit

3. P Relationships tab > Add
4. Enter the Address and the Relationship type

Relationship o3
Address 1001019.00 Edit | | Del
| Prosound o
" | Silva Johnson
Pokerst. 50
New York
" Phone 123456789
Mobile Phone 123456789
Company Phone 123456789
Home Phone 123456789
Fax: 123456789 G
Relationship Partrer e
Type
Concel

5 p Ok

Creating a Relationship Type in the Master Data

1. easyjob Menu o Master Data g Relationship Type

o> Add
Enter a Name

2 Ok

H o
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CRM - Address Master Data

Leads

Before you create a potential customer (e.g. an interested person at a trade show) in detail in
your Address Master Data, you can enter him as a Lead ¥ in easyjob. On the Main Data " ",
Advanced &, Custom Fields S5, Activities %, Campaigns & and Blocking Indicator / tabs,
you can use many CRM functions also for the Lead. If this lead becomes a customer, then the
lead can be Converted (C to the Address Master Data.

in

General Information
Company
Company 2
Salutation
Last Name
First Name
Street
Zip Code, City
Country
Phone
Mobile Phone
E-Mail
Department

Position

Creator: Brad Casagni Brighton (08.05.2018 11:35)

-~ "9 0 0 0 @ —==
Data Custom Felds Activities Campai Blocking Indicator
[Agency for Catering Events Inc. ‘
l l
Hello v
[shay l
[David [ ]
\ l
l Il |
[1258-9850-6810 |
( l
[#c@events.com
l l
l |
Q Convert Save Cancel
Last Edited: @

Creating a lead:

1. easyjob Menu > Master Data g Addresses
2. P Add

Address

Q Lead

3. Plead ¥

4. Enter the information
5 po Save

Edit

In your Address Main Data, you can not only by Addresses and Contacts, but also by Leads * *.

Main Data

Enter general information as well as communication details (e.g. CRM Owner) in the Main

Data.

53

& Addresses [E=8 HoR ==
Keyword Address Type %
Customer DryHire v [ Addesses [ Contacts Leads |/ [] Display deactivated  [] Activate List Editor
Type  Number Own Number  Company Salutation FistName LastName ContactSalutation ContactFirstName  ContactLastName ContactPhone  Contact Phone Mobile €
Address  1001019.00 Prosound Dear Sir Silva Johnson
Contact  1001019.00 Prosound Dear Sir Silva Johnson Dear Sir Silva Johnson 123456783 123456789 1
Address  1000003.00 800500701 XY Event Productions  Dear Sir or Madam
Contact 1000003.00 800500701 XY Event Productions  Dear Sir or Madam Dear Madam Hans Schmith 0123888812 0177 888888 €
Contact 100000300 800500701 XY EventProductions  Dear Sit or Madam Dear Madam Kordes Sanne 0123888821 01234 83883 C
Contact  1000003.00 800500701 XY Event Productions  Dear Sir or Madam Dear Sir or Madam 1235550000 01234 88883 C
<




CRM - Address Master Data

Advanced
The Advanced ¥ tab contains the same fields found on the CRM Advanced tab " * for an
Address. In addition, you can enter the CRM Owner & and the Industry 5.

[ & |msal
nced Custom Fields Activities Campaigns Blocking Indicator
RM Oviner Brad Casagni Brighton v
try |Eventagency v
Status Hot v
The next big thing [ABBA Revival Tour I
Source [Meet and Great at summer event ]
R by [xY Event Productions ]
Preferred Contact Method | Phone v
> VI
Projectbudgetperyesr [0
e
Nodemos [ W)
Acquisition channel |campaign v|
[Eaty Brd |[’][X]
Newsletter Status [Invied v

[ Comvert || save |[oK ][ Concel |

Creator: Brad Casagni Brighton (08.05.2018 11:35) Last Edited: @

Custom Fields
The Customer Fields are identical to those for the Address Master Data.

Activities

Here you can find an overview of the Activities ¥ assigned to this lead Address. The content of
the Activities tab is analogous to the Address Master Data. The Level * * column indicates if it
is a Lead, Contact or Address.

Main Data Custom Fields chiviti [= i ing Indicator

Stort[[101.05.2018_~| End[[107.062018 v| Manager [] %] Brad Cosagni Bightan | (] Include Groups

Keyword | | (1 Only running Activities

Start End Type [Name Priority Direction  Manager Finalized | Finalized by Lovel
08052016 0B052018 2  Presentation of newproducts MNormsl Outgoing Brad Casagni Brighton n Lezd
08052018 08052012 B Invitaion Normal Ouigoing Andy Schedule Stockholm 7] Prad Casagni Brighton  Leod

List  Preview

Name Description Name Path |

Creator: Brad Casagni Brighton (08.05.2018 11:35) Last Edited: (D)

Campaigns
The campaign information is identical to the information in the Address Master Data.

Msin Data Advanced Custom Fields Activities Campaigns Blocking Indicator

Name Start End
Newsletter 06102017 1314 13.10201713:14
Opening city store 030420171119 100420171119

Covert || Sawe [ 0K || Cancel |

Creator: Brad Casagni Brighton (08.05.2018 11:35) Last Edited: @
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CRM - Address Master Data

Blocking indicators
You can activate the same Blocking indicators in the Lead as in the Contact. See also
Contacts and ¥ Blocking indicators.

Lesd =[5 [
Main Data Advanced Custom Fields Activities C: igns  Blocking Indicator

Blocking Indicator

[[] Dezctivated
E-Mail
Phone
Convert Save Cancel
Creator: Brad Casagni Brighton (08.05.2018 11:35)  Last Edited: @

Converting a Lead into an Address
Converting a lead:

1. easyjob Menu o Master Data g Addresses
2. o Select the Lead
3. P> Convert

Lo oo
Main Data Advanced Custom Felds Activities G igns  Blocking Indicator

General Information

Company ‘ﬁgencylor Catering Events Inc |
Company 2 ‘ |
Salutation Hello ~

Last Name ‘Shc"y |
First Name [David Il |
ks L Comen T
Zip Code, City [ n

Country

0 Should the Lead be converted into an Address?

il

Phone

Mabile Phone

E-Mail |aicee) Abbrechen

Department ’_ |

Position [ |

Save oK Cancel

Creator: Brad Casagni Brighton (08.05.2018 11:35) Last Edited: Brad Casagni Brighton (08.05.2018 11:45) @
4. P Ok
5. Enter any additional information for the Address
6. o Save

Leads in the Dashboard

The CRM Dashboard is also available for Leads. You can display the Address Main Data,
Activities, Timeline, Advanced Information, Campaigns and Events. More information can be
found in F Dashboard.
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CRM - Dashboard

Dashboard

With the CRM dashboard you are informed about all processes of a selected address. You can
see all information and data about your customer at a glance.

56

ZL» CRM Dashboard
— T T T T I _ T T T T T T T T T T T I _T T T T T | T T T T T T T T T T T
" 2016 2017 2018 [
January 2017 December 2017 2
5 P
800500701 XY Event Productions XA
Main Data "/ ~  Additional Information /' ~ Sales Trends "/ 2
@ XY Event Productions Rating
) Notes: start up company 1
101 Sample Drive Industry Supplier\Eventagency 800004
75219 Dallas Discount Rental: 5%
o Discount Sales:
Phone: 123-456-7892 CRM Owner: Milan Slava Pras
Mobile Phone: 01234 88889 Blocking Indicator: ‘Confirm Project/Job, Send E-Mail 60000
Company Phone: 123-555-0000  Reason of block: Unpaid Invoice
Home Phone: 01234 83889 CRM Status: Cold
Fax: 01234 88889 Contact Method: E-Mail 40,000
E-Mail: info@xyevents.com The next big thing World-Tour 2020
Intemet: htpy//www.rm.biz Source: Personal contact during Opening After Show
Recommended by: Prostage Inc
Number of Projects per 50 20,000+
year:
Project budget per year:  $100.00
No. of employees: 3 04 ) ! . . ’ . ¢ 3 Y . .
Sales: $500.00 2017 Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec
Contacts /' 2
Salutation First Name Middle Name LastName CompanyPhone  Home Phone Mobile Phone Fax E-Mail Department Position
Dear Sir or Madam 123-555-0000 01234 83889 01234 83889 01234 88889 info@xyevents.com
Dear Madam Kordes Sanne 0123 8888-21 01234 83889 0123 8888-22 om Head HR
Dear Madam Hans Schmith 0123 8888-12 0177883888 01238888-13 hschmith@xyevents.com Sales CEo
Timeline 7 a
Tuesday, May 29, 2018
2:30 PM - Customer question about proposal ]
Wednesday, May 23, 2018
B 10:00 AM - Follow-up Check if event run fine
Tuesday, May 22, 2018
2:08 PM - Spring-Special
3:31 PM - New customers action
3:09 PM - Snap the chance!
-] 1:03 PM - Complain Invoive Missing ltems
Tuesday, May 8, 2018
Invitation
Monday, May 7, 2018
18-0004 aBC Product Lounge Part 2
Agreements o
Subject Description Start End Active
Letter of intent  cooperation until 2018 3/16/2017 418PM 12/31/2018418PM @
Master Agreement 10 % discount for minimum 100.000,00 EUR tumover per year 5/1/20174:18PM  5/2/2019 4:18 PM o
Relationships &
Relationship Type Address
Customer 1000030.00 Portland Crew Support
Partner 1001019.00 Prosound
Partner 1000033.00 SOLA Lighting Rental
Supplier 1000010.00 Big Events Inc.
Projects by Customer /' ®
Start End Number Own Number Project Name Manager Status  Type Priority Customer Site Notes
2/10/2017 1200 AM 2/16/2017 11:41 AM 17-0015 Shopping Center « Confirmed Normal XY Event Productions Stockholm
4/1/2017 1200 AM  4/6/2017 1200 AM  17-0027 Product show event fair cc Proposed Normal XY Event Productions Stockholm
9/1/20171200AM  9/3/2017 1200AM  17-0028 Dance Hall Festival AD Proposed festival Normal XY Event Productions Stockholm
9/1/2017 1200 AM  12/1/2017 1200 AM  17-002 European Tour 2017 cc Confirmed Normal XY Event Productions Stockholm M

rotonic software GmbH
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CRM - Dashboard

You can open the CRM Dashboard via the context menu (right mouse click) of the Address ¥
or the Contact " *. You can also access the CRM Dashboard via the Communication menu &.
You can also open it directly S5 in the Address Book.

oy | [<au> | <Al Continents> | A Addesses [ Contacts [JLead |77

Type Number Company Street . ZipCode City  County Contact Salutation  Contact First Name  Contact LastName  State  Phone E-Mail
® Addiess  1000003.00 XY Event Productions 101 Sample Drive 75213 Dallas _ United States 1234567832 info@nyevents.com |
& Contact 100000300 XY Event Productions 101 Sample Drive 75219 Dallas  Urited Stal Edit Address 1234567832 info@nyevents.com
& Contact 100000300 XY EventProductions 101 SampleDive 75219 Dallas  Urited Si @ ion » Z) CRM Dashboard 1234567892 info@xyevents.com

j XY Event Productions 101 SampleDrive 76213 Dallas  UnitedStates  DearMadam  Hans

Edit Address

& E-Mail d L
-Mai 23456 7652 | EioGgovents o
Edit Contact n

Facebook

Send Text Message

Internet

E-Mail
& e [3) Bing Maps
Intermet.

< ' [S) Bing Maps

»
Send Text Message  »
5
»

General  Activities  CustomFields  Invoices  Total Sales  Resources Jobs Rating Document Timeline Facebook

Number 1000003.00 Custom Number ¥ inege
Company [xY Event Productions | Phone (0123888812 ] ﬂ

In nearly all points in easyjob where an Address or a Contact is used, you can open the
Communication menu with the right mouse button. For example, in the Project %o.

Opening the Dashboard:

1. easyjob Menu > View > Addresses
Select an Address/Contact

[ Right mouse button g Communication
I CRM Dashboard

Mo

or

3. > Dashboard button
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